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Product notice
This guide describes features that are
common to most models. Some features may
not be available on your computer.
Not all features are available in all editions
of Windows 8. This computer may require
upgraded and/or separately purchased
hardware, drivers, and/or software to take
full advantage of Windows 8 functionality.
See http://www.microsoft.com for details.
Software terms
By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to
be bound by the terms of the HP End User
License Agreement (EULA). If you do not
accept these license terms, your sole remedy
is to return the entire unused product
(hardware and software) within 14 days for
a refund subject to the refund policy of your
place of purchase.
For any further information or to request a
full refund of the computer, please contact
your local point of sale (the seller).

Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Product Name

HP ZBook 15 Mobile Workstation

Processors

●

Intel® Quad Core® i7-4900MQ 2.80-GHz (SC turbo up to 3.80-GHz) processor
(1600-MHz front-side bus (FSB), 8.0-MB L3 cache, 47 W)

●

Intel Quad Core i7-4800MQ 2.70-GHz (SC turbo up to 3.70-GHz) processor
(1600-MHz FSB, 6.0-MB L3 cache, 47 W)

●

Intel Quad Core i7-4700MQ 2.40-GHz (SC turbo up to 3.40-GHz) processor
(1600-MHz FSB, 6.0-MB L3 cache, 47 W)

●

Intel Quad Core i7-4600M 2.90-GHz (SC turbo up to 3.60-GHz) processor
(1600-MHz FSB, 4.0-MB L3 cache, 37 W)

●

Intel Dual Core i5-4330M 2.80-GHz (SC turbo up to 3.50-GHz) processor (1600MHz FSB, 3.0-MB L3 cache, 37 W)

●

Intel Dual Core i5-4300M 2.60-GHz (SC turbo up to 3.30-GHz) processor (1600MHz FSB, 3.0-MB L3 cache, 37 W)

Chipset

Mobile Intel QM87

Graphics

Switchable graphics:
●

NVIDIA® Quadro® K2100M NVIDIA N15P-Q3 with 2-GB GDDR5 graphics
subsystem memory (128-MB×16, 1.35-V, 1500-MHz, qty 8, 128-bit, FBW)

●

NVIDIA Quadro K1100M NVIDIA N15P-Q1 with 2-GB GDDR5 graphics
subsystem memory (128-MB×16, 1.35-V, 1400-MHz, qty 8, 128-bit, FBW)

●

NVIDIA Quadro K610M NVIDIA N15M-Q2 with 1-GB GDDR5 graphics
subsystem memory (128-MB×16, 1.35-V, 1300-MHz, qty 4, 64-bit, FBW)

Support for hybrid (switchable) graphics
Support for open GL
Support for DisplayPort 1.2
Support for up to 4 total displays (through APR)
Support for NVIDIA Mosaic Technology
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Category

Description

Panel

●

15.6-in, full-high definition (FHD), AntiGlare (AG), RGB, light-emitting diode (LED),
UWVA (1920×1080 resolution, 210 nits, 109% CG), DreamColor (7.2-mm,
wedge design, eDP panel) with camera, not available with WWAN capability

●

15.6-in, FHD, AG, RGB, LED, UWVA, DreamColor, without camera, not available
with WWAN capability

●

15.6-in, FHD, AG, LED, UWVA (1920×1080 resolution, 300 nits, 72% CG slim),
non-DreamColor (3.8-mm flat design, eDP panel) with camera

●

15.6-in, FHD, AG, LED, UWVA, non-DreamColor without camera

●

15.6-in, FHD, AG, LED, SVA with camera

●

15.6-in, FHD, AG, LED, SVA without camera

All panels are 16:9 aspect ratio
Memory

Four customer-accessible/upgradable memory module slots
Support for DDR3L 1600-MHz PC3-12800 dual channel memory
Support for 8192-MB of system RAM in the following configurations:

Flash cache

●

32768-MB total system memory (8192-MB×4)

●

16384-MB total system memory (8192-MB×2 or 4096-MB×4)

●

8192-MB total system memory (8192-MB×1 or 4096-MB×2)

●

4096-MB total system memory (4096-MB×1)

32-GB MLC mSATA module (Intel Smart Response Technology (SRT)
Dedicated MiniCard slot
Support for no flash cache option
Fast Flash Standby not supported
Not available on computer models equipped with a solid-state drive (SSD) or a selfencrypted drive (SED)
Not available on computer models equipped with the Linus operating system

MiniCard solid-state drive

128-GB mSATA SSD
Not available if 32-GB flash cache is selected
SSD is set as primary storage if selected; hard drive becomes secondary storage
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Chapter 1 Product description

Category

Description

Hard drive

Support for 6.35-cm (2.5-in) hard drives in 7.0-mm (.28-in) and 9.5-mm (.37in) thickness
Support for Serial ATA
Support for 3D DriveGuard hard drive protection
Support toolless removal
Support for the following hard drives:
●

1-TB, 5400-rpm, 9.5-mm

●

750-GB, 7200-rpm, 7.0-mm

●

500-GB, 7200-rpm, 7.0-mm

●

500-GB, 5400-rpm, 7.0-mm, FIPS (not available on computer models equipped
with the Windows 8, Windows 7, or Windows 8 downgrade operating systems)

●

500-GB, 7200-rpm, 7.0-mm, self-encrypting drive (not available on computer
models equipped with the Windows 8, Windows 7, or Windows 8 downgrade
operating systems)

●

320-GB, 7200-rpm, 7.0-mm

Support for the following 6.35-cm (2.5-in) solid-state drives:

Upgrade drive

●

512-GB SATA-3 SSD

●

256-GB SATA-3 self-encrypting SSD (not available on computer models equipped
with the Windows 8, Windows 7, or Windows 8 downgrade operating systems)

●

180-GB SATA-3 SSD

●

128-GB SATA-3 SSD

Support for the following 9.5-mm (.37-in) , SATA optical drives:
●

Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

●

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

●

DVD±RW SuperMulti Double-Layer Drive

●

DVD-ROM Drive

Support for 6.35-cm (2.5-in) 750-GB, 7200-rpm SATA hard drive in 7.0-mm (.28-in)
and 9.5-mm (.37-in) thicknesses
Support for the following 6.35-cm (2.5-in) SATA III solid-state drives:
●

512-GB SSD

●

256-GB SED SSD (not available on computer models equipped with the
Windows 8, Windows 7, or Windows 8 downgrade operating systems)

Supports for no Upgrade drive option (bezel)
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Category

Description

Audio and video

Stereo speakers
Dual array microphone
HD Audio with DTS Studio sound
DTS sound+
Integrated HD 720p webcam (fixed [no tilt], activity LED, 1280×720 by 30 frames
per second)
Support for no webcam option

Ethernet

Intel I217-LM 10/100/1000 Ethernet, with Intel I217-LM Gigabit Network Connection
Support for Power Optimizer
Intel Stable Image Platform Program (SIPP)

Wireless

Integrated wireless local area network (WLAN) options by way of wireless module
Two WLAN antennas built into display assembly
Support for the following WLAN formats:
●

Intel Centrino Advanced-N 6205 Combo Adapter

●

Intel Centrino Advanced-N 6235 Combo Adapter

●

Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi + BT 4.0
Combo Adapter

Integrated wireless wide area network (WWAN) options by way of wireless module
(select models only)
Two WWAN antennas built into display assembly
Security provided by subscriber identify module (SIM), slot located in battery bay
Support for the following WWAN formats:

External media cards
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●

HP hs3110 HSPA+ Mobile Broadband Module

●

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module

●

HP lt4112 LTE/HSPA+ Mobile Broadband Module

HP 2-in-1 multiformat Digital Media Reader Slot with push-push technology. Reads data
from and writes data to digital memory cards such as Secure Digital (SD).

Category

Description

Ports

●

AC adapter, HP Smart

●

Audio-in (mono microphone)/audio-out (stereo headphone) combo jack

●

Battery (secondary)

●

DisplayPort 1.2

●

Docking

●

RJ45 (Ethernet)

●

Thunderbolt

●

USB 3.0 (2)

●

USB 3.0 charging (1)

●

USB: 2.0 (1)

●

VGA (Dsub 15 pin) supporting: 1920×1200 external resolution @ 75 Hz, hot plug
and unplug and autodetection for correct output to wide-aspect vs. standard
aspect video

Keyboard/pointing devices

Full-size, island-style, backlit (and non-backlit) keyboard with numeric keypad
Gesture support: MultiTouch gestures enabled, two-finger scrolling, and pinchzoom as default
Support for Windows 8 dual-point (pointing stick with 3 pointing stick buttons plus
TouchPad with 3 TouchPad buttons)
DuraKeys
Spill Resistant with drain
TouchPad requirements:
●

On/off button

●

Glass with chemical etched surface (DuraPad)

●

Support for 2-way scroll

●

Taps enabled by default

●

Gestures enabled by default:

●
Power requirements

◦

2-finger scrolling

◦

2-finger zoom (pinch)

Image sensor TouchPad

Support for the following AC adapters:
●

200-W, HP Smart Adapter, slim

●

150-W, HP Smart Adapter, slim

●

120-W, HP Smart Adapter, slim

5

Category

Description

Power requirements (continued)

Support for the following batteries

Security

●

9-cell, 100-WHr, 3.0-AHr, Li-ion battery

●

9-cell, 73-WHr, 2.2-AHr, Li-ion battery

●

8-cell, 83-WHr, 2.8-AHr, Li-ion battery

●

8-cell, 75-WHr, 2.8-AHr, Li-ion battery

Support security lock
Trusted platform module (TPM) 1.2 (Infineon; soldered down) and TPM Enhanced Drive
Lock (For the People's Republic of China and Asia Pacific countries and regions,
disabled but available)
Fingerprint reader
Integrated smart card reader

Operating system

Preinstalled:
●

Windows 8 CH 64-bit (only available in the People's Republic of China with
Hardware Kit)

●

Windows 8 EM 64-bit

●

Windows 8 ML 64-bit

●

Windows 8 Professional 64-bit

●

Windows 8 Professional 64-bit DPK with Windows 7 Professional 64-bit Image
(not supported in the People's Republic of China)

●

Windows 7 Professional 64-bit

●

FreeDOS 2.0

●

SuSE Linux Enterprise (SLED 11) Service Pack 2, 64-bit (not available on computer
models equipped with WWAN capability or a Blu-ray R/RE DVD±RW SuperMulti
Double-Layer Drive or Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

Restore media-DRDVD:
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●

DRDVD Windows 8 (available with any Windows 8 loc, required any Windows 8
Professional downgrade operating system)

●

DRDVD Windows 7 (available with any Windows 8 or Windows 7 Professional
downgrade loc)

●

SRDVD SuSE Linux Enterprise (SLED) Service Pack 2, 64-bit (available with
FreeDOS and SuSE Linux)

Category

Description

Operating system (continued)

Restore media-OSDVD:
●

Windows 8 64-bit (for service only)

●

Windows 8 Country-Specific 64-bit (for service only)

●

Windows 8 Emerging Market 64-bit (for service only)

●

Windows 8 Professional 64-bit (only available and required with Windows 8
downgrade operating systems)

●

Windows 7 Professional 64 -bit (available with any Windows 8 Professional or
Windows 7 Professional downgrade loc, not available in the People's Republic
of China)

Certified::
●

Microsoft WHCK

●

SuSE Linux Enterprise (SLED) Service Pack 2, 64-bit

Web-only support:

Serviceability

●

Windows 8.1 64-bit

●

Windows 8.1 Professional 64-bit

●

Windows 7 Enterprise 64-bit

●

Windows 7 Enterprise 32-bit

●

Windows 7 Professional 32-bit

●

Windows 7 Ultimate 64-bit

●

Windows 7 Ultimate 32-bit

●

SuSE Linux Enterprise (SLED) Service Pack 2, 64-bit (closed source drivers)

End user replaceable parts:
●

AC adapter

●

Battery (system)

●

Hard drive

●

Keyboard

●

Memory modules (4, 2 expansion and 2 primary)

●

mSATA SSD

●

Optical drive

●

SSD

●

WLAN module

●

WWAN module
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External component identification

Display
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Item

Component

Description

(1)

WLAN antennas (2, select models only)*

Send and receive wireless signals to communicate with a
WLAN.

(2)

WWAN antennas (2, select models only)*

Send and receive wireless signals to communicate with a
WWAN.

(3)

Internal microphones (2)

Record sound.

(4)

Webcamera light (select models only)

On: The webcam is in use.

Chapter 2 External component identification

Item

Component

Description

(5)

Webcamera (select models only)

Records video and captures still photographs.
For information on using the webcamera in Windows 8,
access HP Support Assistant. To access HP Support
Assistant on the Start screen, select the HP Support
Assistant app.
For information on using the webcamera in Windows 7,
select Start > All Programs > Communication
and Chat > HP WebCam.

(6)

Internal display switch

Turns off the display or initiates Sleep if the display is
closed while the power is on.
NOTE: The display switch is not visible on the outside
of the computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. To access this guide, from the Start screen, type support, select
the HP Support Assistant app, select My computer, and then select User guides.

Display
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Buttons, speakers, and fingerprint reader (select
models only)

Item

Component

Description

(1)

Power button

●

When the computer is off, press the button to turn on
the computer.

●

When the computer is on, press the button briefly to
initiate Sleep.

●

When the computer is in the Sleep state, press the
button briefly to exit Sleep.

●

When the computer is in Hibernation, press the
button briefly to exit Hibernation.

CAUTION: Pressing and holding down the power
button will result in the loss of unsaved information.
If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.
To learn more about your power settings, see your power
options. From the Start screen, type power, select
Settings, and then select Power Options.
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Item

Component

Description

(2)

Speakers (2)

Produce SRS Premium Sound or SRS Premium Sound PRO
(select models only).
NOTE: To use the SRS Premium Sound software, from
the Start screen, type SRS, and then select SRS Pro
Audio.

(3)

Wireless button

Turns the wireless feature on or off but does not establish
a wireless connection.

(4)

Volume mute button

Mutes and restores speaker sound.

(5)

Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a
password logon.

Buttons, speakers, and fingerprint reader (select models only)

11

Keys

Item

Component

Description

(1)

esc key

Displays system information when pressed in combination
with the fn key.

(2)

fn key

Executes frequently used system functions when pressed
in combination with a function key, the num lk key, the
esc key, or the b key.

(3)

Windows button

Returns you to the Start screen from an open app or the
Windows desktop.
NOTE: Pressing the Windows button again will return
you to the previous screen.
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(4)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

(5)

num lk key

Alternates between the navigational and numeric
functions on the integrated numeric keypad.

(6)

Integrated numeric keypad

When num lk has been enabled, it can be used like an
external numeric keypad.

Chapter 2 External component identification

Lights

Item

Component

Description

(1)

Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off.

(2)

Caps lock light

On: Caps lock is on.

(3)

Microphone mute light

●

Amber: Microphone sound is off.

●

Off: Microphone sound is on.

(4)

Num lock light

On: Num lock is on.

(5)

Wireless light

●

White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

●

Amber: All wireless devices are off.

●

Amber: Computer sound is off.

●

Off: Computer sound is on.

(6)

Mute light

Lights
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TouchPad
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Item

Component

Description

(1)

Pointing stick

Moves the pointer and selects or activates items on the
screen.

(2)

Left pointing stick button

Functions like the left button on an external mouse.

(3)

TouchPad on/off button

Turns the TouchPad on and off.

(4)

TouchPad zone

Moves the pointer and selects or activates items on the
screen.

(5)

Left TouchPad button

Functions like the left button on an external mouse.

(6)

Right pointing stick button

Functions like the right button on an external mouse.

(7)

Center pointing stick button

Functions like the center button on an external mouse.

(8)

Center TouchPad button

Functions like the center button on an external mouse.

(9)

Right TouchPad button

Functions like the right button on an external mouse.

Chapter 2 External component identification

Front

Item

Component

Description

(1)

Wireless light

●

White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

●

Amber: All wireless devices are off.

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off.

●

White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

●

Off: The battery is fully charged.

●

Blinking white: The hard drive is being accessed.

●

Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(2)

(3)

(4)

Power light

AC adapter/Battery light

Hard drive light

Front
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Left side

Item

Component

Description
(7) Smart card reader Supports optional smart cards. (8)
ExpressCard slot Supports optional ExpressCards.

(1)

Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2)

USB 2.0 port

Connects an optional USB device.

(3)

Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(4)

Thunderbolt port

Connects an optional high-resolution display device or a
high-performance data device.
NOTE: Thunderbolt is new technology. Install all the
latest drivers for your Thunderbolt device before
connecting the device to the Thunderbolt. Thunderbolt
cable and Thunderbolt device (sold separately) must be
compatible with Windows. To determine whether your
device is Thunderbolt Certified for Windows, see
https://thunderbolttechnology.net/products.
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(5)

Dual-Mode DisplayPort

Connects an optional digital display device, such as a
high-performance monitor or projector.

(6)

USB 3.0 charging port

Connects optional USB 3.0 devices and provide
enhanced USB power performance. The USB charging
port can also charge select models of cell phones and
MP3 players, even when the computer is off.

(7)

Smart card reader

Supports optional smart cards.

(8)

ExpressCard slot

Supports optional ExpressCards.

Chapter 2 External component identification

Right side

Item

Component

Description

(1)

Memory card reader

Reads data from and writes data to memory cards such
as Secure Digital (SD).

(2)

Audio-out (headphone) jack/Audio-in
(microphone) jack

Connects optional powered stereo speakers,
headphones, earbuds, a headset, or a television audio
cable. Also connects an optional headset microphone.
This jack does not support optional microphone-only
devices.
WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and Environmental
Notices. To access this guide, from the Start screen, type
support, select the HP Support Assistant app,
select My computer, and then select User guides.
NOTE: When a device is connected to the jack, the
computer speakers are disabled.
NOTE: Be sure that the device cable has a 4-conductor
connector that supports both audio-out (headphone) and
audio-in (microphone).

(3)

USB 3.0 port

Connects an optional USB device.

(4)

Optical drive (select models only)

Reads and writes, depending on your computer model, to
an optical disc.
NOTE: For disc compatibility information, navigate to
the Help and Support web page. Follow the web page
instructions to select your computer model. Select
Support & Drivers, and then select Product
Information.

(5)

Optical drive eject button (select models
only)

Releases the optical drive disc tray.

(6)

External monitor port

Connects an external VGA monitor or projector.

Right side
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Rear

Item

Component

Description

(1)

USB 3.0 port

Connects optional USB 3.0 devices and provides
enhanced USB power performance.

(2)

Power connector

Connects an AC adapter.

(3)

AC adapter/Battery light

●

White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

●

Off: The battery is fully charged.

(4)
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RJ45 (network) jack

Connects a network cable.

RJ45 (network) lights (2)

●

Green (left): The network is connected.

●

Amber (right): The network is showing activity.
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Bottom

Item

Component

Description

(1)

Battery release latch

Releases the battery.

(2)

Battery bay

Holds the battery.

(3)

SIM slot

Supports a wireless subscriber identity module (SIM)
(select models only). The SIM slot is located inside the
battery bay.

(4)

Docking connector

Connects an optional docking device.

(5)

Accessory battery connector

Connects an optional accessory battery.

(6)

Service cover release lock

Locks the service cover.

(7)

Service cover release latch

Releases the service cover on the computer.

Bottom
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Item

Component

Description

(8)

Vents (3)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(9)

Service cover

Provides access to the hard drive bay, the WLAN module
slot, the WWAN module slot, and the memory module
slots.
CAUTION: To prevent an unresponsive system, replace
the wireless modules only with wireless modules
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the modules and then receive a
warning message, remove the modules to restore
computer functionality, and then contact support through
HP Support Assistant. To access HP Support Assistant
from the Start screen, select the HP Support Assistant
app.
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3

Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag.

Item

Description

Function

(1)

Product name

This is the product name affixed to the front of
the computer.

Service tag
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Item

Description

Function

(2)

Serial number (s/n)

This is an alphanumeric identifier that is unique to
each product.

(3)

Part number/Product number (p/n)

This number provides specific information about
the product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4)

Warranty period

This number describes the duration of the warranty
period for the computer.

(5)

Model description

This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Chapter 3 Illustrated parts catalog

Computer major components

Computer major components
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Item

Component

Spare part number

(1)

Display assembly: The DreamVision display assembly is spared as a whole unit assembly only. The LED display
assembly is spared at the subcomponent level only. For more LED display assembly spare part information, see LED
display assembly subcomponents on page 30.
15.6-in, FHD, UWVA, DreamVision display assembly equipped with a webcamera

735965-001

15.6-in, FHD, UWVA, DreamVision display assembly not equipped with a webcamera

735964-001

Hinge Cover Kit, includes:

734294-001

(2a)

Hinge cover (includes HP logo)

(2b)

Left-side rear corner cover

(2c)

Right-side-side rear corner cover

(3)

Keyboard (includes keyboard cable):
Keyboard with backlight and pointing stick (includes keyboard cable, backlight cable, and pointing stick cable):
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For use in Belgium

733688-A41

For use in Brazil

733688-201

For use in Bulgaria

733688-261

For use in Canada

733688-DB1

For use in the Czech Republic and Slovakia

733688-FL1

For use in Denmark

733688-081

For use in France

733688-051

For use in Germany

733688-041

For use in Greece

733688-151

For use in Hungary

733688-211

For use in Iceland

733688-DD1

For use in India

733688-D61

For use in Israel

733688-BB1

For use in Italy

733688-061

For use in Japan

733688-291

For use in Latin America

733688-161

For use in the Netherlands

733688-B31

For use in Northwest Africa

733688-FP1

For use in Norway

733688-091

For use in Portugal

733688-131

For use in Romania

733688-271

For use in Russia

733688-251
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Item

Component

Spare part number

For use in Saudi Arabia

733688-171

For use in Slovenia

733688-BA1

For use in South Korea

733688-AD1

For use in Spain

733688-071

For use in Sweden and Finland

733688-B71

For use in Switzerland

733688-BG1

For use in Taiwan

733688-AB1

For use in Thailand

733688-281

For use in Turkey

733688-141

For use in the United Kingdom and Singapore

733688-031

For use in the United States

733688-001

Keyboard with pointing stick (includes keyboard cable and pointing stick cable):
For use in Belgium

745663-A41

For use in Brazil

745663-201

For use in Bulgaria

745663-261

For use in Canada

745663-DB1

For use in the Czech Republic and Slovakia

745663-FL1

For use in Denmark

745663-081

For use in France

745663-051

For use in Germany

745663-041

For use in Greece

745663-151

For use in Hungary

745663-211

For use in Iceland

745663-DD1

For use in Israel

745663-BB1

For use in Italy

745663-061

For use in Japan

745663-291

For use in Latin America

745663-161

For use in the Netherlands

745663-B31

For use in Northwest Africa

745663-FP1

For use in Norway

745663-091

For use in Portugal

745663-131

For use in Romania

745663-271

Computer major components
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Item

(4)

Spare part number

For use in Russia

745663-251

For use in Saudi Arabia

745663-171

For use in Slovenia

745663-BA1

For use in South Korea

745663-AD1

For use in Spain

745663-071

For use in Sweden and Finland

745663-B71

For use in Switzerland

745663-BG1

For use in Taiwan

745663-AB1

For use in Thailand

745663-281

For use in Turkey

745663-141

For use in the United Kingdom and Singapore

745663-031

For use in the United States

745663-001

Primary memory module (PC3L, 12800, 1600-MHz):
8-GB

693374-001

4-GB

691740-001

(5)

Top cover (includes TouchPad, TouchPad cable, and TouchPad bracket)

734281-001

(6)

Power button board (includes cable)

734285-001

(7)

Function button board (includes cable and double-sided adhesive)

734284-001

(8)

Fingerprint reader board (includes cable and double-sided adhesive)

734286-001

(9)

ExpressCard assembly (includes activity LEDs and Thunderbolt port, Dual Mode
DisplayPort, and USB port)

734287-001

(10)

Smart card reader (includes cable)

742159-001

(11)

Audio/USB board (includes SD Card reader)

734288-001

(12)

Fan/heat sink assembly (includes replacement thermal material):

(13)
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Component

For use only with an NVIDIA Quadro K1100M NVIDIA N15P-Q1 graphics board,
spare part number 734276-001

734289-001

For use only with an NVIDIA Quadro K610M NVIDIA N15M-Q2 graphics board,
spare part number 745325-001

734290-001

For use only with an NVIDIA Quadro K2100M NVIDIA N15P-Q3 graphics board,
spare part number 734277-001

734291-001

Processor (includes replacement thermal material):
Intel Quad Core i7-4900MQ 2.80-GHz (SC turbo up to 3.80-GHz) processor (1600MHz FSB, 8.0-MB L3 cache, 47 W)

723523-002

Intel Quad Core i7-4800MQ 2.70-GHz (SC turbo up to 3.70-GHz) processor (1600MHz FSB, 6.0-MB L3 cache, 47 W)

723524-002
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Item

(14)

Component

Spare part number

Intel Quad Core i7-4700MQ 2.40-GHz (SC turbo up to 3.40-GHz) processor (1600MHz FSB, 6.0-MB L3 cache, 47 W)

723521-002

Intel Quad Core i7-4600M 2.90-GHz (SC turbo up to 3.60-GHz) processor (1600MHz FSB, 4.0-MB L3 cache, 37 W)

737330-002

Intel Dual Core i5-4330M 2.80-GHz (SC turbo up to 3.50-GHz) processor (1600MHz FSB, 3.0-MB L3 cache, 37 W)

738201-002

Intel Dual Core i5-4300M 2.60-GHz (SC turbo up to 3.30-GHz) processor (1600MHz FSB, 3.0-MB L3 cache, 37 W)

738309-002

Graphics board (includes replacement thermal material):
NVIDIA Quadro K1100M NVIDIA N15P-Q1 graphics board

734276-001

NVIDIA Quadro K610M NVIDIA N15M-Q2 graphics board

745325-001

NVIDIA Quadro K2100M NVIDIA N15P-Q3 graphics board

734277-001

(15)

USB board (includes cable and double-sided adhesive)

734293-001

(16)

Speakers (include cable)

734292-001

(17)

RJ-45 (network) cable (included in the Cable Kit, spare part number 734283-001)

(18)

Power connector cable (included in the Cable Kit, spare part number 734283-001)

(19)

System board (includes battery connector bracket and replacement thermal material):
For use only on computer models equipped with an Intel Quad Core processor and the
Windows 8 Professional operating system

734304-601

For use only on computer models equipped with an Intel Quad Core processor and the
Windows 8 Standard operating system

734304-501

For use only on computer models equipped with an Intel Quad Core processor and the
Linux operating system

734304-001

For use only on computer models equipped with an Intel Dual Core processor and the
Windows 8 Professional operating system

734303-601

For use only on computer models equipped with an Intel Dual Core processor and the
Windows 8 Standard operating system

734303-501

For use only on computer models equipped with an Intel Dual Core processor and the
Linux operating system

734303-001

(20)

base enclosure (includes 4 rubber feet, battery lock latch, battery release latch,
and RJ-45 cover)

734279-001

(21)

Expansion memory modules (2, PC3L, 12800, 1600-MHz):

(22)

8-GB

693374-001

4-GB

691740-001

Solid-state drive (SSD):
512-GB SATA-3 SSD

738714-001

256-GB SATA-3 self-encrypting SSD

735598-001

Computer major components
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Item

(23)

(24)

(25)

(26)

28

Component

Spare part number

180-GB SATA-3 SSD

735597-001

128-GB SATA-3 SSD

735596-001

128-GB mSATA-3 SSD

735595-001

32-GB mSATA flash cache SSD

735594-001

WWAN module:
HP hs3110 HSPA+ Mobile Broadband Module

723895-001

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module

704030-001

HP lt4112 LTE/HSPA+ Mobile Broadband Module

704031-001

WLAN module:
Intel Centrino Advanced-N 6205 Combo Adapter

695915-001

Intel Centrino Advanced-N 6235 Combo Adapter

670292-001

Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi + BT 4.0 Combo Adapter

710661-001

Hard drive (does not include hard drive bracket or screws):
1-TB, 5400-rpm, 9.5-mm

676521-001

750-GB, 7200-rpm, 7.0-mm

633252-001

500-GB, 7200-rpm, 7.0-mm

703267-001

500-GB, 5400-rpm, 7.0-mm, FIPS

730946-001

500-GB, 7200-rpm, 7.0-mm, self-encrypting

703268-001

320-GB, 7200-rpm, 7.0-mm

634862-001

Hard Drive Hardware Kit (not illustrated, includes hard drive bracket and screws)

734280-001

Optical drive (includes bezel and bracket):
Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

735600-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

735599-001

DVD±RW SuperMulti Double-Layer Drive

735602-001

DVD-ROM Drive

735601-001

Hard drive upgrade bay

734298-001

(27)

RTC battery (includes cable and double-sided adhesive)

734300-001

(28)

Service cover

734278-001

(29)

Battery:
9-cell, 100-WHr, 3.0-AHr, Li-ion battery

634087-001

9-cell, 73-WHr, 2.2-AHr, Li-ion battery

634089-001
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Item

Component

Spare part number

8-cell, 83-WHr, 2.8-AHr, Li-ion battery

708456-001

8-cell, 75-WHr, 2.8-AHr, Li-ion battery

708455-001

Computer major components
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LED display assembly subcomponents

Item

Component

(1)

Display bezel:

(2)

For use only on computer models equipped with a webcamera

734301-001

For use only on computer models not equipped with a webcamera

734302-001

Display panel:
15.6-in, FHD, UWVA, LED display panel

735607-001

15.6-in, FHD, SVA, LED display panel

735604-001

Webcamera/microphone module (includes double-sided adhesive)

734295-001

Microphone module (includes double-sided adhesive)

735370-001

(4)

Display hinges (includes left and right hinges and display panel cable bracket)

738311-001

(5)

Display Panel Support Kit (includes display enclosure, display panel cable, and
wireless antenna cables and transceivers)

734296-001

(3)
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Spare part number
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Bracket Kit

Item

Component

Spare part number

Bracket Kit, includes:

734299-001

(1)

Security cable lock bracket

(2)

Fingerprint reader board bracket

Bracket Kit
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Cable Kit

Item

Component

Spare part number

Cable Kit, includes:

734283-001

(1)

RJ-45 (network) cable

(2)

Power connector cable
Replacement thermal material (not illustrated)
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Plastics Kit

Item

Component

Spare part number

Plastics Kit, includes:

734297-001

(1)

ExpressCard reader bezel

(2)

Fingerprint reader blank cover

(3)

Fingerprint reader bezel

(4)

SD card reader bezel

(5)

System lens

Plastics Kit
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Mass storage devices

Item

Component

(1)

Solid-state drive (SSD):

(2)

Spare part number

512-GB SATA-3 SSD

738714-001

256-GB SATA-3 self-encrypting SSD

735598-001

180-GB SATA-3 SSD

735597-001

128-GB SATA-3 SSD

735596-001

128-GB mSATA-3 SSD

735595-001

32-GB mSATA flash cache SSD

735594-001

Hard Drive Hardware Kit, includes:

734280-001

Hard drive bracket
Screws (not illustrated)

(3)
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Hard drive (does not include hard drive bracket or screws):
1-TB, 5400-rpm, 9.5-mm

676521-001

750-GB, 7200-rpm, 7.0-mm

633252-001

500-GB, 7200-rpm, 7.0-mm

703267-001

500-GB, 5400-rpm, 7.0-mm, FIPS

730946-001
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Item

(4)

Component

Spare part number

500-GB, 7200-rpm, 7.0-mm, self-encrypting

703268-001

320-GB, 7200-rpm, 7.0-mm

634862-001

Optical drive (includes bezel and bracket):
Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

735600-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

735599-001

DVD±RW SuperMulti Double-Layer Drive

735602-001

DVD-ROM Drive

735601-001

Hard drive upgrade bay

734298-001

Miscellaneous parts
Component

Spare part number

AC adapter:
200-W HP Smart adapter (PFC, 3-wire, 4.5-mm)

693708-001

150-W HP Smart adapter (PFC, 3-wire, 4.5-mm)

693707-001

120-W HP Smart adapter (PFC, 3-wire, 4.5-mm)

693709-001

Cable lock:
Docking station cable lock

575921-001

HP ultraslim keyed cable lock

703372-001

HP professional slim top-load carrying case

703888-001

Mouse:
HP comfort grip wireless mouse

691922-001

HP USB laser mouse

674318-001

Power cord (3-pin, black, 1.83-m):
For use in Argentina

490371-D01

For use in Australia

490371-011

For use in Brazil

490371-202

For use in Europe

490371-021

For use in India

490371-D61

For use in Israel

490371-BB1

For use in Italy

490371-061

For use in Japan

490371-291

Miscellaneous parts
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36

Component

Spare part number

For use in North America

490371-001

For use in the People's Republic of China

490371-AA1

For use in South Africa

490371-AR1

For use in South Korea

490371-AD1

For use in Switzerland

490371-111

For use in Taiwan

490371-AB1

For use in Thailand

490371-201

For use in the United Kingdom and Singapore

490371-031

Screw Kit

734282-001
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Sequential part number listing
Spare part number

Description

490371-001

Power cord for use in North America (3-pin, black, 1.83-m)

490371-011

Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021

Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031

Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-061

Power cord for use in Italy (3-pin, black, 1.83-m)

490371-111

Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201

Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202

Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291

Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1

Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1

Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1

Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1

Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1

Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01

Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61

Power cord for use in India (3-pin, black, 1.83-m)

575921-001

Docking station cable lock

633252-001

750-GB, 7200-rpm, SATA, 7.0-mm hard drive (does not include hard drive bracket or screws)
NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 734280-001.

634087-001

9-cell, 100-WHr, 3.0-AHr, Li-ion battery

634089-001

9-cell, 73-WHr, 2.2-AHr, Li-ion battery

634862-001

320-GB, 7200-rpm, SATA, 7.0-mm hard drive (does not include hard drive bracket or screws)
NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 734280-001.

670292-001

Intel Centrino Advanced-N 6235 Combo Adapter

674318-001

HP USB laser mouse

676521-001

1-TB, 5400-rpm, SATA, 9.5-mm hard drive (does not include hard drive bracket or screws)
NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 734280-001.

691740-001

4-GB memory module (PC3L, 12800, 1600-MHz)

691922-001

HP comfort grip wireless mouse

Sequential part number listing
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Spare part number

Description

693374-001

8-GB memory module (PC3L, 12800, 1600-MHz)

693707-001

150-W HP Smart adapter (PFC, 3-wire, 4.5-mm)

693708-001

200-W HP Smart adapter (PFC, 3-wire, 4.5-mm)

693709-001

120-W HP Smart adapter (PFC, 3-wire, 4.5-mm)

695915-001

Intel Centrino Advanced-N 6205 Combo Adapter

703267-001

500-GB, 7200-rpm, SATA, 7.0-mm hard drive (does not include hard drive bracket or screws)
NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 734280-001.

703268-001

500-GB, 7200-rpm, SATA, 7.0-mm self-encrypting drive (SED, does not include hard drive bracket
or screws)
NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 734280-001.

703372-001

HP ultraslim keyed cable lock

703888-001

HP professional slim top-load carrying case

704030-001

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module

704031-001

HP lt4112 LTE/HSPA+ Mobile Broadband Module

708455-001

8-cell, 75-WHr, 2.8-AHr, Li-ion battery

708456-001

8-cell, 83-WHr, 2.8-AHr, Li-ion battery

710661-001

Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi + BT 4.0 Combo Adapter

723521-002

Intel Quad Core i7-4700MQ 2.40-GHz (SC turbo up to 3.40-GHz) processor (1600-MHz FSB,
6.0-MB L3 cache, 47 W; includes replacement thermal material)

723523-002

Intel Quad Core i7-4900MQ 2.80-GHz (SC turbo up to 3.80-GHz) processor (1600-MHz FSB,
8.0-MB L3 cache, 47 W; includes replacement thermal material)

723524-002

Intel Quad Core i7-4800MQ 2.70-GHz (SC turbo up to 3.70-GHz) processor (1600-MHz FSB,
6.0-MB L3 cache, 47 W; includes replacement thermal material)

723895-001

HP hs3110 HSPA+ Mobile Broadband Module

730946-001

500-GB, 5400-rpm, SATA, 7.0-mm FIPS hard drive (does not include hard drive bracket or screws)
NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 734280-001.
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733688-001

Keyboard with backlight and pointing stick for use in the United States (includes keyboard cable,
backlight cable, and pointing stick cable)

733688-031

Keyboard with backlight and pointing stick for use in the United Kingdom and Singapore (includes
keyboard cable, backlight cable, and pointing stick cable)

733688-041

Keyboard with backlight and pointing stick for use in Germany (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-051

Keyboard with backlight and pointing stick for use in France (includes keyboard cable, backlight
cable, and pointing stick cable)
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Spare part number

Description

733688-061

Keyboard with backlight and pointing stick for use in Italy (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-071

Keyboard with backlight and pointing stick for use in Spain (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-081

Keyboard with backlight and pointing stick for use in Denmark (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-091

Keyboard with backlight and pointing stick for use in Norway (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-131

Keyboard with backlight and pointing stick for use in Portugal (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-141

Keyboard with backlight and pointing stick for use in Turkey (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-151

Keyboard with backlight and pointing stick for use in Greece (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-161

Keyboard with backlight and pointing stick for use in Latin America (includes keyboard cable,
backlight cable, and pointing stick cable)

733688-171

Keyboard with backlight and pointing stick for use in Saudi Arabia (includes keyboard cable,
backlight cable, and pointing stick cable)

733688-201

Keyboard with backlight and pointing stick for use in Brazil (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-211

Keyboard with backlight and pointing stick for use in Hungary (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-251

Keyboard with backlight and pointing stick for use in Russia (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-261

Keyboard with backlight and pointing stick for use in Bulgaria (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-271

Keyboard with backlight and pointing stick for use in Romania (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-281

Keyboard with backlight and pointing stick for use in Thailand (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-291

Keyboard with backlight and pointing stick for use in Japan (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-A41

Keyboard with backlight and pointing stick for use in Belgium (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-AB1

Keyboard with backlight and pointing stick for use in Taiwan (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-AD1

Keyboard with backlight and pointing stick for use in South Korea (includes keyboard cable,
backlight cable, and pointing stick cable)

733688-B31

Keyboard with backlight and pointing stick for use in the Netherlands (includes keyboard cable,
backlight cable, and pointing stick cable)

Sequential part number listing
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Spare part number

Description

733688-B71

Keyboard with backlight and pointing stick for use in Sweden and Finland (includes keyboard
cable, backlight cable, and pointing stick cable)

733688-BA1

Keyboard with backlight and pointing stick for use in Slovenia (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-BB1

Keyboard with backlight and pointing stick for use in Israel (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-BG1

Keyboard with backlight and pointing stick for use in Switzerland (includes keyboard cable,
backlight cable, and pointing stick cable)

733688-D61

Keyboard with backlight and pointing stick for use in India (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-DB1

Keyboard with backlight and pointing stick for use in Canada (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-DD1

Keyboard with backlight and pointing stick for use in Iceland (includes keyboard cable, backlight
cable, and pointing stick cable)

733688-FL1

Keyboard with backlight and pointing stick for use in the Czech Republic and Slovakia (includes
keyboard cable, backlight cable, and pointing stick cable)

733688-FP1

Keyboard with backlight and pointing stick for use in Northwest Africa (includes keyboard cable,
backlight cable, and pointing stick cable)

734276-001

NVIDIA Quadro K1100M NVIDIA N15P-Q1 graphics board

734277-001

NVIDIA Quadro K2100M NVIDIA N15P-Q3 graphics board

734278-001

Service cover

734279-001

base enclosure

734280-001

Hard Drive Hardware Kit

734281-001

Top cover (includes TouchPad, TouchPad cable, and TouchPad bracket)

734282-001

Screw Kit

734283-001

Cable Kit (includes power connector cable and RJ-45 (network) cable and replacement
thermal material)

734284-001

Function button board (includes cable and double-sided adhesive)

734285-001

Power button board (includes cable)

734286-001

Fingerprint reader board (includes cable and double-sided adhesive)

734287-001

ExpressCard assembly (includes activity LEDs and Thunderbolt port, Dual Mode DisplayPort, and
USB port)

734288-001

Audio/USB board (includes SD Card reader)

734289-001

Fan/heat sink assembly for use only with an NVIDIA Quadro K1100M NVIDIA N15P-Q1 graphics
board (includes replacement thermal material)

734290-001

Fan/heat sink assembly for use only with an NVIDIA Quadro K610M NVIDIA N15M-Q2 graphics
board (includes replacement thermal material)
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Spare part number

Description

734291-001

Fan/heat sink assembly for use only with an NVIDIA Quadro K2100M NVIDIA N15P-Q3 graphics
board (includes replacement thermal material)

734292-001

Speakers

734293-001

USB board (includes cable and double-sided adhesive)

734294-001

Display hinge cover (includes HP logo)

734295-001

Webcamera/microphone module (includes double-sided adhesive)

734296-001

Display Panel Support Kit (includes display enclosure, display panel cable, and wireless antenna
cables and transceivers)

734297-001

Plastics Kit

734298-001

Hard drive upgrade bay

734299-001

Bracket Kit

734300-001

RTC battery (includes cable and double-sided adhesive)

734301-001

Display bezel for use only on computer models equipped with a webcamera

734302-001

Display bezel for use only on computer models not equipped with a webcamera

734303-001

System board for use only on computer models equipped with an Intel Dual Core processor and the
Linux operating system (includes battery connector bracket and replacement thermal material)

734303-501

System board for use only on computer models equipped with an Intel Dual Core processor and the
Windows 8 Standard operating system (includes battery connector bracket and replacement
thermal material)

734303-601

System board for use only on computer models equipped with an Intel Dual Core processor and the
Windows 8 Professional operating system (includes battery connector bracket and replacement
thermal material)

734304-001

System board for use only on computer models equipped with an Intel Quad Core processor and
the Linux operating system (includes battery connector bracket and replacement thermal material)

734304-501

System board for use only on computer models equipped with an Intel Quad Core processor and
the Windows 8 Standard operating system (includes battery connector bracket and replacement
thermal material)

734304-601

System board for use only on computer models equipped with an Intel Quad Core processor and
the Windows 8 Professional operating system (includes battery connector bracket and replacement
thermal material)

735370-001

Microphone module (includes double-sided adhesive)

735594-001

32-GB mSATA flash cache solid-state drive

735595-001

128-GB mSATA-3 solid-state drive

735596-001

128-GB SATA-3 solid-state drive

735597-001

180-GB SATA-3 solid-state drive

735598-001

256-GB SATA-3 self-encrypting solid-state drive

735599-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

Sequential part number listing
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Spare part number

Description

735600-001

Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

735601-001

DVD-ROM Drive

735602-001

DVD±RW SuperMulti Double-Layer Drive

735604-001

15.6-in, FHD, SVA, LED display panel

735607-001

15.6-in, FHD, UWVA, LED display panel

735964-001

15.6-in, FHD, UWVA, DreamVision display assembly not equipped with a webcamera

735965-001

15.6-in, FHD, UWVA, DreamVision display assembly equipped with a webcamera

737330-002

Intel Quad Core i7-4600M 2.90-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz FSB, 4.0MB L3 cache, 37 W; includes replacement thermal material)

738201-002

Intel Dual Core i5-4330M 2.80-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz FSB, 3.0MB L3 cache, 37 W; includes replacement thermal material)

738309-002

Intel Dual Core i5-4300M 2.60-GHz (SC turbo up to 3.30-GHz) processor (1600-MHz FSB, 3.0MB L3 cache, 37 W; includes replacement thermal material)

738311-001

Hinge Kit (includes left and right hinges and display panel cable bracket)

738714-001

512-GB SATA-3 solid-state drive

742159-001

Smart card reader (includes cable)

745325-001

NVIDIA Quadro K610M NVIDIA N15M-Q2 graphics board

745663-001

Keyboard with pointing stick for use in the United States (includes keyboard cable and pointing
stick cable)

745663-031

Keyboard with pointing stick for use in the United Kingdom and Singapore (includes keyboard
cable and pointing stick cable)

745663-041

Keyboard with pointing stick for use in Germany (includes keyboard cable and pointing stick cable)

745663-051

Keyboard with pointing stick for use in France (includes keyboard cable and pointing stick cable)

745663-061

Keyboard with pointing stick for use in Italy (includes keyboard cable and pointing stick cable)

745663-071

Keyboard with pointing stick for use in Spain (includes keyboard cable and pointing stick cable)

745663-081

Keyboard with pointing stick for use in Denmark (includes keyboard cable and pointing stick cable)

745663-091

Keyboard with pointing stick for use in Norway (includes keyboard cable and pointing stick cable)

745663-131

Keyboard with pointing stick for use in Portugal (includes keyboard cable and pointing stick cable)

745663-141

Keyboard with pointing stick for use in Turkey (includes keyboard cable and pointing stick cable)

745663-151

Keyboard with pointing stick for use in Greece (includes keyboard cable and pointing stick cable)

745663-161

Keyboard with pointing stick for use in Latin America (includes keyboard cable and pointing
stick cable)

745663-171

Keyboard with pointing stick for use in Saudi Arabia (includes keyboard cable and pointing
stick cable)

745663-201

Keyboard with pointing stick for use in Brazil (includes keyboard cable and pointing stick cable)
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Spare part number

Description

745663-211

Keyboard with pointing stick for use in Hungary (includes keyboard cable and pointing stick cable)

745663-251

Keyboard with pointing stick for use in Russia (includes keyboard cable and pointing stick cable)

745663-261

Keyboard with pointing stick for use in Bulgaria (includes keyboard cable and pointing stick cable)

745663-271

Keyboard with pointing stick for use in Romania (includes keyboard cable and pointing stick cable)

745663-281

Keyboard with pointing stick for use in Thailand (includes keyboard cable and pointing stick cable)

745663-291

Keyboard with pointing stick for use in Japan (includes keyboard cable and pointing stick cable)

745663-A41

Keyboard with pointing stick for use in Belgium (includes keyboard cable and pointing stick cable)

745663-AB1

Keyboard with pointing stick for use in Taiwan (includes keyboard cable and pointing stick cable)

745663-AD1

Keyboard with pointing stick for use in South Korea (includes keyboard cable and pointing
stick cable)

745663-B31

Keyboard with pointing stick for use in the Netherlands (includes keyboard cable and pointing
stick cable)

745663-B71

Keyboard with pointing stick for use in Sweden and Finland (includes keyboard cable and pointing
stick cable)

745663-BA1

Keyboard with pointing stick for use in Slovenia (includes keyboard cable and pointing stick cable)

745663-BB1

Keyboard with pointing stick for use in Israel (includes keyboard cable and pointing stick cable)

745663-BG1

Keyboard with pointing stick for use in Switzerland (includes keyboard cable and pointing
stick cable)

745663-DB1

Keyboard with pointing stick for use in Canada (includes keyboard cable and pointing stick cable)

745663-DD1

Keyboard with pointing stick for use in Iceland (includes keyboard cable and pointing stick cable)

745663-FL1

Keyboard with pointing stick for use in the Czech Republic and Slovakia (includes keyboard cable
and pointing stick cable)

745663-FP1

Keyboard with pointing stick for use in Northwest Africa (includes keyboard cable and pointing
stick cable)

Sequential part number listing
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4

Removal and replacement
procedures preliminary
requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screw driver

●

Magnetic screw driver

●

Phillips P0 and P1 screw drivers

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Service considerations
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Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.
CAUTION: A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity
Event
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10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

●

Use conductive field service tools, such as cutters, screw drivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.

Grounding guidelines
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
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Material

Use

Voltage protection level

Antistatic plastics

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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5

Removal and replacement
procedures for Customer SelfRepair parts

NOTE: The Customer Self-Repair program is not available in all locations. Installing a part not
supported by the Customer Self-Repair program may void your warranty. Check your warranty to
determine if Customer Self-Repair is supported in your location.

Component replacement procedures
NOTE: Please read and follow the procedures described here to access and replace Customer SelfRepair parts successfully.
NOTE: Details about your computer, including model, serial number, product key, and length of
warranty, are on the service tag at the bottom of your computer. See Service tag on page 16
for details.
This chapter provides removal and replacement procedures for Customer Self-Repair parts.
There are as many as 16 screws that must be removed, replaced, and/or loosened when servicing
Customer Self-Repair parts. Make special note of each screw size and location during removal
and replacement.

Component replacement procedures
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Battery
Description

Spare part number

9-cell, 100-WHr, 3.0-AHr, Li-ion battery

634087-001

9-cell, 73-WHr, 2.2-AHr, Li-ion battery

634089-001

8-cell, 83-WHr, 2.8-AHr, Li-ion battery

708456-001

8-cell, 75-WHr, 2.8-AHr, Li-ion battery

708455-001

Before removing the battery, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

Remove the battery:
WARNING! To reduce potential safety issues, use only the user-replaceable battery provided with
the computer, a replacement battery provided by HP, or a compatible battery purchased from HP.
CAUTION: Removing a user-replaceable battery that is the sole power source for the computer can
cause loss of information. To prevent loss of information, save your work or shut down the computer
through Windows before removing the battery.
1.

Turn the computer upside down on a flat surface.

2.

Slide the battery release latch (1) to release the battery.
NOTE: The battery release latch automatically returns to its original position.

3.
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Pivot the battery (2) upward.
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4.

Remove the battery (3) from the computer.

Reverse this procedure to install the battery.

Service cover
Description

Spare part number

Service cover

734278-001

Before removing the service cover, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50).

Remove the service cover:
1.

Slide the service cover release latch to the left (1), and then remove the optional Phillips
PM2.0×4.5 screw (if the screw is being used) (2).
NOTE: If you want to use the optional screw, it is stored inside the service cover.

2.

Slide the release latch again (3) to release the service cover.

Component replacement procedures
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3.

Slide the service cover toward the front of the computer (4), and then lift to remove the
service cover (5).

Reverse this procedure to install the service cover.

Hard drive
NOTE: The hard drive spare part kit does not include the hard drive bracket or screws. These
components are included in the Hard Drive Hardware Kit, spare part number 734280-001.
Description

Spare part number

1-TB, 5400-rpm, 9.5-mm

676521-001

750-GB, 7200-rpm, 7.0-mm

633252-001

500-GB, 7200-rpm, 7.0-mm

703267-001

500-GB, 5400-rpm, 7.0-mm, FIPS

730946-001

500-GB, 7200-rpm, 7.0-mm, self-encrypting

703268-001

320-GB, 7200-rpm, 7.0-mm

634862-001

Before removing the hard drive, follow these steps:
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1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.
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4.

Remove the battery (see Battery on page 50).

5.

Remove the service cover (see Service cover on page 51).

Remove the hard drive:
1.

Loosen the 3 hard drive captive screws (1).

2.

Pull the hard drive tab (2) to the left to disconnect the hard drive.

3.

Lift the hard drive (3), and then pull the hard drive out of the hard drive bay.

4.

If it is necessary to disassemble the hard drive, perform the following steps:
a.

Position the hard drive with the hard drive tab toward you.

b.

Remove the four Phillips PM3.0×3.5 screws (1) that secure the hard drive bracket to the
hard drive.

c.

Remove the hard drive bracket (2) from the hard drive.
The hard drive bracket and screws are available in the Hard Drive Hardware Kit, spare part
number 734280-001.

Component replacement procedures
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Reverse this procedure to install the hard drive.

Optical drive
NOTE: The optical drive spare part kit includes a bezel and bracket.
Description

Spare part number

Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

735600-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

735599-001

DVD±RW SuperMulti Double-Layer Drive

735602-001

DVD-ROM Drive

735601-001

Hard drive upgrade bay

734298-001

Before removing the optical drive, follow these steps:
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1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.
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4.

Remove the battery (see Battery on page 50).

5.

Remove the service cover (see Service cover on page 51).

Remove the optical drive:
1.

Position the computer with the left side toward you.

2.

Loosen the captive screw (1) that secures the optical drive to the computer.

3.

Insert a thin tool into the optical drive tab access (2) and press the tab to the left to release the
optical drive from the computer.

4.

Remove the optical drive (3).

Reverse this procedure to install the optical drive.

Component replacement procedures
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WWAN module
Description

Spare part number

HP hs3110 HSPA+ Mobile Broadband Module

723895-001

HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module

704030-001

HP lt4112 LTE/HSPA+ Mobile Broadband Module

704031-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.
Before removing the WWAN module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50).

5.

Remove the service cover (see Optical drive on page 54).

Remove the WWAN module:
1.

Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.
NOTE: The WWAN antenna cable labeled “5” connects to the WWAN module “Main”
terminal labeled “5”. The WWAN antenna cable labeled “6” connects to the WWAN module
“Aux/GPS” terminal labeled “6”.

2.
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Remove the Phillips PM2.0×3.25 screw (2) that secures the WWAN module to the system board.
(The WWAN module tilts up.)
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3.

Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WWAN antenna cables are not connected to the terminals on the WWAN module,
protective sleeves should be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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Solid-state drive
Description

Spare part number

512-GB SATA-3 SSD

738714-001

256-GB SATA-3 self-encrypting SSD

735598-001

180-GB SATA-3 SSD

735597-001

128-GB SATA-3 SSD

735596-001

128-GB mSATA-3 SSD

735595-001

32-GB mSATA flash cache SSD

735594-001

Before removing the solid-state drive, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50).

5.

Remove the service cover (see Service cover on page 51).

Remove the solid-state drive:
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1.

Remove the two Phillips PM2.0×3.5 screws (1) that secure the solid-state drive to the system
board. (The solid-state drive tilts up.)

2.

Remove the solid-state drive (2) by pulling the drive away from the slot at an angle.
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Reverse this procedure to install the solid-state drive.

WLAN module
Description

Spare part number

Intel Centrino Advanced-N 6205 Combo Adapter

695915-001

Intel Centrino Advanced-N 6235 Combo Adapter

670292-001

Intel Dual Band Wireless-AC 7260 802.11 ac 2×2 WiFi + BT 4.0 Combo Adapter

710661-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.
Before removing the WLAN module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.
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4.

Remove the battery (see Battery on page 50).

5.

Remove the service cover (see Service cover on page 51).

Remove the WLAN module:
1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”.

2.

Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the system
board. (The WLAN module tilts up.)

3.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WLAN antenna cables are not connected to the terminals on the WLAN module,
protective sleeves should be installed on the antenna connectors, as shown in the following illustration.
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Reverse this procedure to install the WLAN module.

Primary memory module
Description

Spare part number

8-GB (PC3L, 12800, 1600-MHz)

693374-001

4-GB (PC3L, 12800, 1600-MHz)

691740-001

Update BIOS before adding memory modules
Before adding new memory, make sure you update the computer to the latest BIOS.
CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.
To update BIOS:
1.

Navigate to www.hp.com.

2.

Click Support & Drivers > click Drivers & Software.

3.

In the Enter a product name/number box, type the computer model information, and then
click Search.

4.

Click the link for the computer model.

5.

Select the operating system, and then click Next.

6.

Under Step 2: Select a Download, click the BIOS link.

7.

Click the link for the most recent BIOS.

8.

Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.
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3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50).

5.

Remove the service cover (see Optical drive on page 54).

Remove the memory module:
1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)

2.

Remove the memory module (2) by pulling the module away from the slot at an angle.

Reverse this procedure to install a memory module.

Keyboard
For use in country or region
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Spare part
number

For use in country or
region

Spare part number

Keyboard with backlight and pointing stick (includes keyboard
cable, backlight cable, and pointing stick cable):

For use in the Netherlands

733688-B31

For use in Belgium

733688-A41

For use in Northwest Africa

733688-FP1

For use in Brazil

733688-201

For use in Norway

733688-091

For use in Bulgaria

733688-261

For use in Portugal

733688-131

For use in Canada

733688-DB1

For use in Romania

733688-271

For use in the Czech Republic
and Slovakia

733688-FL1

For use in Russia

733688-251

For use in Denmark

733688-081

For use in Saudi Arabia

733688-171
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For use in country or region

Spare part
number

For use in country or
region

Spare part number

For use in France

733688-051

For use in Slovenia

733688-BA1

For use in Germany

733688-041

For use in South Korea

733688-AD1

For use in Greece

733688-151

For use in Spain

733688-071

For use in Hungary

733688-211

For use in Sweden and Finland

733688-B71

For use in Iceland

733688-DD1

For use in Switzerland

733688-BG1

For use in India

733688-D61

For use in Taiwan

733688-AB1

For use in Israel

733688-BB1

For use in Thailand

733688-281

For use in Italy

733688-061

For use in Turkey

733688-141

For use in Japan

733688-291

For use in the United Kingdom
and Singapore

733688-031

For use in Latin America

733688-161

For use in the United States

733688-001

Keyboard with pointing stick (includes keyboard cable and pointing stick cable):
For use in Belgium

745663-A41

For use in Northwest Africa

745663-FP1

For use in Brazil

745663-201

For use in Norway

745663-091

For use in Bulgaria

745663-261

For use in Portugal

745663-131

For use in Canada

745663-DB1

For use in Romania

745663-271

For use in the Czech Republic
and Slovakia

745663-FL1

For use in Russia

745663-251

For use in Denmark

745663-081

For use in Saudi Arabia

745663-171

For use in France

745663-051

For use in Slovenia

745663-BA1

For use in Germany

745663-041

For use in South Korea

745663-AD1

For use in Greece

745663-151

For use in Spain

745663-071

For use in Hungary

745663-211

For use in Sweden and Finland

745663-B71

For use in Iceland

745663-DD1

For use in Switzerland

745663-BG1

For use in Israel

745663-BB1

For use in Taiwan

745663-AB1

For use in Italy

745663-061

For use in Thailand

745663-281

For use in Japan

745663-291

For use in Turkey

745663-141

For use in Latin America

745663-161

For use in the United Kingdom
and Singapore

745663-031

For use in the Netherlands

745663-B31

For use in the United States

745663-001
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Before removing the keyboard, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50).

5.

Remove the service cover (see Service cover on page 51).

6.

Remove the optical drive (see Optical drive on page 54).

Remove the keyboard:
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1.

Loosen the two captive screws that secure the keyboard to the computer.

2.

Partially open the computer.

3.

Rest and secure the computer on its left side.
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4.

Insert a thin tool into the keyboard release hole in the optical drive bay, and then press on the
back of the keyboard until the keyboard disengages from the computer.

5.

Turn the computer right-side up, with the front toward you.

6.

Open the computer as far as it will open.

7.

Lift the rear edge of the keyboard until it rests at an angle.

8.

Swing the rear edge of the keyboard (1) up and forward until it rests upside down on the
palm rest.

9.

Release the zero insertion force (ZIF) connector (2) to which the keyboard cable is attached, and
then disconnect the keyboard cable from the system board.

10. Release the ZIF connector (3) to which the pointing stick cable is attached, and then disconnect
the pointing stick cable from the system board.
NOTE: Step 11 applies only to computer models equipped with a keyboard with backlight.
11. Release the ZIF connector (4) to which the backlight cable is attached, and then disconnect the
backlight cable from the system board.
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12. Remove the keyboard (5).

Reverse this procedure to install the keyboard.
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Expansion memory module
Description

Spare part number

8-GB (PC3L, 12800, 1600-MHz)

693374-001

4-GB (PC3L, 12800, 1600-MHz)

691740-001

Update BIOS before adding memory modules
Before adding new memory, make sure you update the computer to the latest BIOS.
CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.
To update BIOS:
1.

Navigate to www.hp.com.

2.

Click Support & Drivers > click Drivers & Software.

3.

In the Enter a product name/number box, type the computer model information, and then
click Search.

4.

Click the link for the computer model.

5.

Select the operating system, and then click Next.

6.

Under Step 2: Select a Download, click the BIOS link.

7.

Click the link for the most recent BIOS.

8.

Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50).

5.

Remove the service cover (see Optical drive on page 54).

Remove the memory module:
1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)
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2.

Remove the memory module (2) by pulling the module away from the slot at an angle.

Reverse this procedure to install a memory module.

68

Chapter 5 Removal and replacement procedures for Customer Self-Repair parts

6

Removal and replacement
procedures for Authorized Service
Provider parts

CAUTION: Components described in this chapter should only be accessed by an authorized service
provider. Accessing these parts can damage the computer or void the warranty.

Component replacement procedures
This chapter provides removal and replacement procedures for Authorized Service Provider only parts.
There are as many as 74 screws that must be removed, replaced, and/or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

RTC battery
Description

Spare part number

RTC battery (includes cable and double-sided adhesive)

734300-001

Before removing the RTC battery, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50).

5.

Remove the service cover (see Service cover on page 51).

Remove the RTC battery:
1.

Disconnect the RTC battery cable (1) from the system board.

Component replacement procedures

69

2.

Detach the RTC battery (2) from the base enclosure. (The RTC battery is attached to the
base enclosure with double-sided adhesive.)

3.

Remove the RTC battery and cable.

Reverse this procedure to install the RTC battery.
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Top cover
Description

Spare part number

Top cover (includes TouchPad, TouchPad cable, and TouchPad bracket)

734281-001

Before removing the top cover, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

NOTE: When replacing the top cover, be sure to remove the following components from the defective
top cover and install them on the replacement top cover:
●

Function button board (see Function button board on page 77)

●

Power button board (see Power button board on page 79)

●

Fingerprint reader board (see Fingerprint reader board on page 75)

Remove the top cover:
1.

Close the computer.

2.

Turn the computer upside down with the front toward you.
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3.

Remove the eight Torx T8M2.5×6.5 screws that secure the top cover to the computer.

4.

Remove the following screws that secure the top cover to the computer:
(1) Three Torx T8M2.5×4.5 screws in the optical drive bay
(2) Four Torx T8M2.5×4.5 screws in the battery bay
(3) Two Phillips PM2.0×3.0 screws in the hard drive bay
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5.

Turn the computer right side up with the front toward you.

6.

Open the computer.

7.

Release the ZIF connector (1) to which the power button board cable is attached, and then
disconnect the power button board cable from the system board.

8.

Release the ZIF connector (2) to which the function button board cable is attached, and then
disconnect the function button board cable from the system board.
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9.

Remove the Torx T8M2.5×6.5 screw (3) that secures the top cover to the computer.

10. Lift the rear edge of the top cover (1) until the left and right sides and the front edge detach from
the computer.
11. Slide the top cover (2) forward until the fingerprint reader board cable and the TouchPad cable
are accessible.
12. Release the ZIF connector to which the fingerprint reader board cable is attached, and then
disconnect the fingerprint reader board cable (3) from the system board.
13. Release the ZIF connector to which the TouchPad cable is attached, and then disconnect the
TouchPad cable (4) from the system board.
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14. Remove the top cover (5).

Reverse this procedure to install the top cover.
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Fingerprint reader board
Description

Spare part number

Fingerprint reader board (includes cable and double-sided adhesive)

734286-001

Before removing the fingerprint reader board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

Remove the fingerprint reader board:
1.

Turn the top cover upside down with the front toward you.

2.

Remove the Phillips PM2.0×3.0 screw (1) that secures the fingerprint reader board and bracket to
the top cover.

3.

Slide the fingerprint reader board (2) bracket forward and remove it.
The fingerprint reader board bracket is available in the Bracket Kit, spare part number
734299-001.

4.

Detach the fingerprint reader board cable (3) from the top cover. (The fingerprint reader board
cable is attached to the top cover with double-sided adhesive.)
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5.

Remove the fingerprint reader board (4) and cable.

Reverse this procedure to install the fingerprint reader board.
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Function button board
Description

Spare part number

Function button board (includes cable and double-sided adhesive)

734284-001

Before removing the function button board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

Remove the function button board:
1.

Detach the function button board cable from the top cover. (The function button board cable is
attached to the top cover with double-sided adhesive.)

2.

Turn the top cover upside down, with the front toward you.
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3.

Release the function button board cable through the opening (1) in the top cover.

4.

Remove the Phillips PM2.0×3.0 screw (2) that secures the function button board to the top cover.

5.

Lift the right side of the function button board (3) until it rests at an angle.

6.

Remove the function button board (4) by sliding it up and to the right at an angle.

Reverse this procedure to install the function button board.
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Power button board
Description

Spare part number

Power button board (includes cable)

734285-001

Before removing the power button board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

Remove the power button board:
1.

Turn the top cover upside down, with the front toward you.

2.

Remove the Phillips PM2.0×3.0 screw (1) that secures the power button board to the top cover.

3.

Release the clips (2) that secure the power button board to the top cover.
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4.

Remove the power button board (3) and cable

Reverse this procedure to install the power button board.
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ExpressCard assembly
Description

Spare part number

ExpressCard assembly (includes activity LEDs and Thunderbolt port, Dual Mode DisplayPort, and
USB port)

734287-001

Before removing the ExpressCard assembly, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

Remove the ExpressCard assembly:
1.

Remove the Torx T8M2.5×4.5 screw (1) that secures the system lens to the base enclosure.

2.

Remove the system lens (2).
The system lens is available in the Plastics Kit, spare part number 734297-001.

3.

Remove the three Torx T8M2.5×4.5 screws (3) that secure the ExpressCard assembly to the
base enclosure.
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4.

Disconnect the ExpressCard assembly (4) from the system board by lifting up on the right side of
the assembly.

5.

Remove the the ExpressCard assembly.

Reverse this procedure to install the ExpressCard assembly.
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Smart card reader
Description

Spare part number

Smart card reader (includes cable)

742159-001

Before removing the smart card reader, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

f.

ExpressCard assembly (see ExpressCard assembly on page 81)

Remove the smart card reader:
1.

Release the ZIF connector (1) to which the smart card reader cable is attached, and then
disconnect the smart card reader cable from the system board.

2.

Remove the two Torx T8M2.5×4.5 screws (2) that secure the smart card reader to the
base enclosure.
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3.

Remove the smart card reader (3).

Reverse this procedure to install the smart card reader and cable.
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Audio/USB board
Description

Spare part number

Audio/USB board (includes SD Card reader)

734288-001

Before removing the audio/USB board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

Remove the audio/USB board:
1.

Remove the four Torx T8M2.5×4.5 screws (1) that secure the audio/USB board to the
base enclosure.
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2.

Disconnect the audio/USB board (2) from the system board by lifting up on the left side of the
audio/USB board.

3.

Remove the audio/USB board.

Reverse this procedure to install the audio/USB board.
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USB board
Description

Spare part number

USB board (includes cable and double-sided adhesive)

734293-001

Before removing the USB board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

Remove the USB board:
1.

Release the ZIF connector (1) to which the USB board cable is attached, and then disconnect the
USB board cable from the system board.

2.

Detach the USB board cable (2) from the base enclosure. (The USB board cable is attached to the
base enclosure with double-sided adhesive.)
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3.

Remove the Torx T8M2.5×4.5 screw (3) that secures the USB board to the base enclosure.

4.

Remove the USB board and cable.

Reverse this procedure to install the USB board.
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Speakers
Description

Spare part number

Speakers (includes cable)

734292-001

Before removing the speakers, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

Remove the speakers:
1.

Disconnect the speaker cable (1) from the system board.

2.

Remove the two Phillips PM2.0×3.0 screws (1) that secure the speakers to the base enclosure.
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3.

Remove the speakers (3) and cable.

Reverse this procedure to install the speakers.

Fan/heat sink assembly
NOTE: The fan/heat sink assembly spare part kit includes replacement thermal material.
Description

Spare part number

For use only with an NVIDIA Quadro K1100M NVIDIA N15P-Q1 graphics board, spare part
number 734276-001

734289-001

For use only with an NVIDIA Quadro K610M NVIDIA N15M-Q2 graphics board, spare part
number 745325-001

734290-001

For use only with an NVIDIA Quadro K2100M NVIDIA N15P-Q3 graphics board, spare part
number 734277-001

734291-001

Before removing the fan/heat sink assembly, follow these steps:
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1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.
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3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

Remove the fan/heat sink assembly:
1.

Disconnect the fan cable (1) from the system board.

2.

Following the 1 through 4 sequence stamped into the processor heat sink, loosen the four Phillips
captive screws (2) that secure the processor heat sink to the system board.

3.

Following the 5 through 8 sequence stamped into the graphics board heat sink, loosen the four
Phillips captive screws (3) that secure the graphics board heat sink to the system board.

4.

Remove the fan/heat sink assembly (4).
NOTE: Due to the adhesive quality of the thermal material located between the fan/heat sink
assembly and the system board components, it may be necessary to move the fan/heat sink
assembly from side to side to detach it.
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NOTE: The thermal material must be thoroughly cleaned from the surfaces of the fan/heat sink
assembly and the system board components each time the fan/heat sink assembly is removed.
Replacement thermal material is included with the fan/heat sink assembly, processor, and system board
spare part kits.
●

Various thermal pads are used on the graphics board components (1) and (7) and the heat sink
sections (2) and (8) that service them

●

Thermal paste is used on the processor (3) and the heat sink section (4) that services it

●

Thermal paste is used on the graphics board processor (5) and the heat sink section (6) that
services it

Reverse this procedure to install the fan/heat sink assembly.
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Processor
NOTE: The processor spare part kit includes replacement thermal material.
Description

Spare part number

Intel Quad Core i7-4900MQ 2.80-GHz (SC turbo up to 3.80-GHz) processor (1600-MHz FSB,
8.0-MB L3 cache, 47 W)

723523-002

Intel Quad Core i7-4800MQ 2.70-GHz (SC turbo up to 3.70-GHz) processor (1600-MHz FSB,
6.0-MB L3 cache, 47 W)

723524-002

Intel Quad Core i7-4700MQ 2.40-GHz (SC turbo up to 3.40-GHz) processor (1600-MHz FSB,
6.0-MB L3 cache, 47 W)

723521-002

Intel Quad Core i7-4600M 2.90-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz FSB, 4.0MB L3 cache, 37 W)

737330-002

Intel Dual Core i5-4330M 2.80-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz FSB, 3.0MB L3 cache, 37 W)

738201-002

Intel Dual Core i5-4300M 2.60-GHz (SC turbo up to 3.30-GHz) processor (1600-MHz FSB, 3.0MB L3 cache, 37 W)

738309-002

Before removing the processor, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

f.

Fan/heat sink assembly (see Fan/heat sink assembly on page 90)

Remove the processor:
1.

Use a Torx8 screw driver (1) to turn the processor locking screw one-half turn
counterclockwise (2), until you hear a click.
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2.

Lift the processor (3) straight up, and remove it.
NOTE: The gold triangle (4) on the processor must be aligned with the triangle icon embossed
on the processor socket when you install the processor.

Reverse this procedure to install the processor.

Graphics board
NOTE: The graphics board spare part kit includes replacement thermal material.
Description

Spare part number

NVIDIA Quadro K1100M NVIDIA N15P-Q1 graphics board

734276-001

NVIDIA Quadro K610M NVIDIA N15M-Q2 graphics board

745325-001

NVIDIA Quadro K2100M NVIDIA N15P-Q3 graphics board

734277-001

Before removing the graphics board, follow these steps:
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1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.
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3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

f.

Fan/heat sink assembly (see Fan/heat sink assembly on page 90)

Remove the graphics board:
1.

Remove the two Torx T8M2.5×4.5 screws (1) that secure the graphics board to the system board.
(The graphics board tilts up.)

2.

Remove the graphics board (2) by pulling the board away from the slot at an angle.

Reverse this procedure to install the graphics board.
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Display assembly
NOTE: The DreamVision display assembly is spared as a whole unit assembly only. The LED display
assembly is spared at the subcomponent level only. For more LED display assembly spare part
information, see the individual removal subsections.
Description

Spare part number

15.6-in, FHD, UWVA, DreamVision display assembly equipped with a webcamera

735965-001

15.6-in, FHD, UWVA, DreamVision display assembly not equipped with a webcamera

735964-001

To remove the display assembly and access the LED display assembly subcomponents, follow
these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

Remove the display assembly:
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1.

Close the computer.

2.

Turn the computer upside down, with the rear toward you.

3.

Make sure that the WWAN antenna cables are disconnected from the WWAN module (see
WWAN module on page 56).

4.

Make sure that the WLAN antenna cables are disconnected from the WLAN module (see WLAN
module on page 59).
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5.

Release the wireless antenna cables (1) from the routing clips (2) and channels built into the
base enclosure.

6.

Turn the computer right side up, with the rear toward you.

7.

Remove the four Torx T8M2.0×3.0 screws (1) that secure the hinge cover to the computer.

8.

Remove the hinge cover (2).
The hinge cover is available using spare part number 734294-001.
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9.

Remove the two Torx T8M2.5×4.5 screws that secure the display assembly to the base enclosure.

10. Position the computer with the front toward you.
11. Open the computer as far as it will open.
12. Remove the Phillips PM2.0×3.0 screw (1) that secures the display panel cable and bracket to the
system board.
13. Remove the display panel cable bracket (2).
The display panel cable bracket is included in the Hinge Kit, spare part number 738311-001.
14. Disconnect the display panel cable (3) from the system board.
15. Detach the display panel cable (4) from the base enclosure. (The display panel cable is attached
to the base enclosure with double-sided adhesive.)
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16. Release the wireless antenna cables from the routing channels built into the base enclosure.

17. Remove the two Torx T8M2.5×6.5 screws (1) that secure the display assembly to the
base enclosure.
18. Remove the display assembly (2).

NOTE: Steps 19 through 22 apply only to LED display assemblies.
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19. If it is necessary to replace the display bezel or any of the LED display assembly subcomponents:
a.

Remove the two screw covers (1) and the two Phillips PM2.0×5.5 screws (2) that secure the
display bezel to the display assembly.
The screw covers are available in all LED display assembly subcomponent spare part kits.

b.

Flex the inside edges of the top edge (1), the left and right sides (2), and the
bottom edge (3) of the display bezel until the bezel disengages from the display enclosure.

c.

Remove the display bezel (4).
The display bezel is available using spare part numbers 734301-001 (for use only on
computer models equipped with a webcamera) and 734302-001 (for use only on computer
models not equipped with a webcamera).
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20. If it is necessary to replace the display panel:
a.

Remove the four Phillips PM2.0×3.0 screws that secure the display panel to the
display enclosure.

CAUTION: Before turning the display panel upside down, make sure the work surface is
clear of tools, screws, and any other foreign objects. Failure to follow this caution can result
in damage to the display panel.
b.

Lift the top edge of the display panel (1) and swing it up and forward until it rests upside
down in front of the display enclosure.

c.

Release the adhesive strip (2) that secures the display panel cable connector to the
display panel.

d.

Disconnect the display panel cable (3) from the display panel.

e.

Remove the display panel.
The display panel is available using spare part numbers 735607-001 (15.6-in, FHD,
UWVA, LED display panel) and 735604-001 (15.6-in, FHD, SVA, LED display panel).
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21. If it is necessary to replace the webcamera/microphone module or microphone module:
CAUTION: Handle the webcamera/microphone module and microphone module with caution.
These modules have a thin profile and are susceptible to damage when not handled carefully.
a.

Disconnect the webcamera/microphone module cable (1) from the webcamera/
microphone module.

b.

Detach the webcamera/microphone module (2) from the display enclosure. (The
webcamera/microphone module is attached to the display enclosure with double-sided
adhesive.)

c.

Remove the webcamera/microphone module.
The webcamera/microphone module is available using spare part number 734295-001. The
microphone module is available using spare part number 735370-001.

22. If it is necessary to replace the display hinges:
a.
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Remove the four Torx T8M2.5×4.5 screws (1) that secure the display hinges to the
display panel.
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b.

Remove the display hinges (2).
The display hinges are available using spare part number 738311-001 and include the left
and right hinges.

Reverse this procedure to reassemble and install the display assembly.

System board
NOTE: The system board spare part kit includes battery connector bracket and replacement
thermal material.
Description

Spare part number

For use only on computer models equipped with an Intel Quad Core processor and the
Windows 8 Professional operating system

734304-601

For use only on computer models equipped with an Intel Quad Core processor and the
Windows 8 Standard operating system

734304-501

For use only on computer models equipped with an Intel Quad Core processor and the Linux
operating system

734304-001

For use only on computer models equipped with an Intel Dual Core processor and the Windows 8
Professional operating system

734303-601

For use only on computer models equipped with an Intel Dual Core processor and the Windows 8
Standard operating system

734303-501

For use only on computer models equipped with an Intel Dual Core processor and the Linux
operating system

734303-001

Component replacement procedures
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Before removing the system board, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

f.

ExpressCard assembly (see ExpressCard assembly on page 81)

g.

Audio/USB board (see Audio/USB board on page 85)

h.

Speakers (see Speakers on page 89)

i.

Fan/heat sink assembly (see Fan/heat sink assembly on page 90)

j.

Display assembly (see Display assembly on page 96)

NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:
●

WWAN module (see WWAN module on page 56)

●

Solid-state drive (see Solid-state drive on page 58)

●

WLAN module (see WLAN module on page 59)

●

Expansion memory (see Primary memory module on page 61)

●

Primary memory (see Expansion memory module on page 67)

●

smart card reader (see Smart card reader on page 83)

●

Processor (see Processor on page 93)

●

Graphics board (see Graphics board on page 94)

Remove the system board:
1.

104

Make sure that the RTC battery cable is disconnected from the system board (see RTC battery
on page 69).
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2.

Disconnect the following cables from the system board:
(1) Power connector cable
(2) RJ-45 (network) cable
(3) USB board cable

3.

Remove the right-side rear corner cover (1).
The right-side rear corner cover is included in the Hinge Cover Kit, spare part number
734294-001.
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4.

Remove the seven Torx T8M2.5×4.5 screws (2) that secure the system board to the
base enclosure.

5.

Lift up on the left side of the system board (1) until it rests at an angle.

6.

Remove the system board (2) by sliding it up and to the left at an angle.

Reverse this procedure to install the system board.
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Power connector cable
NOTE: The power connector cable is included in the Cable Kit, spare part number 734283-001.
Before removing the power connector cable, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

f.

ExpressCard assembly (see ExpressCard assembly on page 81)

g.

Audio/USB board (see Audio/USB board on page 85)

h.

USB board (see USB board on page 87)

i.

Speakers (see Speakers on page 89)

j.

Fan/heat sink assembly (see Fan/heat sink assembly on page 90)

k.

Display assembly (see Display assembly on page 96)

Remove the power connector cable:
1.

Disconnect the power connector cable (1) from the system board.

2.

Release the power connector cable (2) from the clips built into the base enclosure.
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3.

Release the power connector (3) from the clips and mold built into the base enclosure.

4.

Remove the power connector cable.

Reverse this procedure to install the power connector cable.
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RJ-45 (network) cable
NOTE: The RJ-45 (network) cable is included in the Cable Kit, spare part number 734283-001.
Before removing the RJ-45 (network) cable, follow these steps:
1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect the power from the computer by unplugging the power cord from the computer.

3.

Disconnect all external devices from the computer.

4.

Remove the battery (see Battery on page 50), and then remove the following components:
a.

Service cover (see Service cover on page 51)

b.

Hard drive (see Hard drive on page 52)

c.

Optical drive (see Optical drive on page 54)

d.

Keyboard (see Keyboard on page 62)

e.

Top cover (see Top cover on page 71)

f.

ExpressCard assembly (see ExpressCard assembly on page 81)

g.

Audio/USB board (see Audio/USB board on page 85)

h.

USB board (see USB board on page 87)

i.

Speakers (see Speakers on page 89)

j.

Fan/heat sink assembly (see Fan/heat sink assembly on page 90)

k.

Display assembly (see Display assembly on page 96)

Remove the RJ-45 (network) cable:
1.

Remove the Phillips PM2.0×5.5 screw (1) that secures the left-side rear corner cover to the
base enclosure.
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2.

Remove the left-side rear corner cover (2).
The left-side rear corner cover is included in the Hinge Cover Kit, spare part number 734294-001.

3.

Remove the Phillips PM2.0×5.5 screw (1) that secures the security cable lock bracket to the
base enclosure.

4.

Remove the security cable lock bracket (2).
The security cable lock bracket is included in the Bracket Kit, spare part number 734299-001.
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5.

Remove the RJ-45 (network) cable (3).

Reverse this procedure to install the RJ-45 (network) cable.

Component replacement procedures

111

7

Computer Setup

Windows 8 — Computer Setup (BIOS), MultiBoot,
and System Diagnostics
Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of
the computer, and the amount of system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
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1.

Turn on or restart the computer, and then press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

press f10 to enter Computer Setup.
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Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2.

press f10 to enter Computer Setup.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key on the keyboard.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen
instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

●

To save your changes and exit Computer Setup menus:
Click the Save icon in the lower-right corner of the screen, and then follow the on-screen
instructions.
– or –
Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring default settings in Computer Setup
NOTE: Restoring default will not change the hard drive mode.
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select File > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the
default settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.
1.

Start Computer Setup.

2.

Use a pointing device or the arrow keys to select File > System Information.

3.

To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner
of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:
Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

From the Start screen, select the HP Support Assistant app.

2.

Select Updates and tune-ups, and then select Check for HP updates now.

3.

At the download area, follow these steps:
a.

Identify the most recent BIOS update and compare it to the BIOS version currently installed on
your computer. Make a note of the date, name, or other identifier. You may need this
information to locate the update later, after it has been downloaded to your hard drive.

b.

Follow the on-screen instructions to download your selection to the hard drive. If the update is
more recent than your BIOS, make a note of the path to the location on your hard drive
where the BIOS update is downloaded. You will need to access this path when you are
ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.
BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:
1.

From the Start screen, type e, and then click File Explorer.

2.

Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3.

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using MultiBoot
About the boot device order
As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can
include optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices.
Boot devices contain bootable media or files that the computer needs to start and operate properly.
NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the
boot order.
You can change the order in which the computer searches for a boot device by changing the boot
order in Computer Setup. You can also press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then press f9. Pressing f9 displays a menu that
shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot
Express to set the computer to prompt you for a boot location each time the computer turns on
or restarts.

Choosing MultiBoot preferences
You can use MultiBoot in the following ways:
●

To set a new boot order that the computer uses each time it is turned on, by changing the boot
order in Computer Setup.

●

To dynamically choose the boot device, by pressing esc while the “press the ESC key for Startup
Menu” message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot
Device Options menu.

●

To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device
each time the computer is turned on or restarted.

Setting a new boot order in Computer Setup
To start Computer Setup and set a boot device order that the computer uses each time it is turned on or
restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then
press enter.

4.

To move the device up in the boot order, use a pointing device to click the up arrow, or
press the + key.
– or –
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To move the device down in the boot order, use a pointing device to click the down arrow, or
press the - key.
5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:
1.

Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc
while the “press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2.

press f9.

3.

Use a pointing device or the arrow keys to select a boot device, then press enter.

Setting a MultiBoot Express prompt
To start Computer Setup and set the computer to display the MultiBoot startup location menu each time
the computer is started or restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select System Configuration > Boot Options,
and then press enter.

4.

In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that
you want the computer to display the startup location menu before it defaults to the current
MultiBoot setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)

5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
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Entering MultiBoot Express preferences
When the Express Boot menu is displayed during startup, you have the following choices:
●

To specify a boot device from the Express Boot menu, select your preference within the allotted
time, and then press enter.

●

To prevent the computer from defaulting to the current MultiBoot setting, press any key before the
allotted time expires. the computer will not start until you select a boot device and press enter.

●

To allow the computer to start according to the current MultiBoot settings, wait for the allotted time
to expire.

Using System Diagnostics
System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly. The following diagnostic tests may be available in System Diagnostics:
●

System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

●

Start-up test—This test analyzes the main computer components that are required to start
the computer.

●

Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

●

Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

●

Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

●

Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

●

BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to main menu.

You can view system information and error logs or select languages in the System Diagnostics window.
To start System Diagnostics:
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1.

Turn on or restart the computer. While the “press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2.

Click the diagnostic test you want to run, and then follow the on-screen instructions.
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NOTE: If you need to stop a diagnostics test while it is running, press esc.
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and HP PC Hardware Diagnostics (UEFI)
Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2.

press f10 to enter Computer Setup.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key on the keyboard.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen
instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

●

To save your changes and exit Computer Setup menus:
Click the Save icon in the lower-right corner of the screen, and then follow the on-screen
instructions.
– or –
Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring default settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select File > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the
default settings.
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Updating the BIOS
Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.
1.

Start Computer Setup.

2.

Use a pointing device or the arrow keys to select File > System Information.

3.

To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner
of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

Downloading a BIOS update
CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:
Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

Access Help and Support by selecting Start > Help and Support.

2.

Select Updates and tune-ups, and then select Check for HP updates now.

3.

At the download area, follow these steps:
a.

Identify the most recent BIOS update and compare it to the BIOS version currently installed on
your computer. Make a note of the date, name, or other identifier. You may need this
information to locate the update later, after it has been downloaded to your hard drive.

b.

Follow the on-screen instructions to download your selection to the hard drive. If the update is
more recent than your BIOS, make a note of the path to the location on your hard drive
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where the BIOS update is downloaded. You will need to access this path when you are
ready to install the update.
NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.
BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:
1.

Select Start > Computer.

2.

Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3.

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4.

Double-click the file that has an .exe extension (for example, filename.exe). The BIOS
installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using MultiBoot
About the boot device order
As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can
include optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices.
Boot devices contain bootable media or files that the computer needs to start and operate properly.
NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the
boot order.
You can change the order in which the computer searches for a boot device by changing the boot
order in Computer Setup. You can also press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then press f9. Pressing f9 displays a menu that
shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot
Express to set the computer to prompt you for a boot location each time the computer turns on
or restarts.
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Choosing MultiBoot preferences
You can use MultiBoot in the following ways:
●

To set a new boot order that the computer uses each time it is turned on, by changing the boot
order in Computer Setup.

●

To dynamically choose the boot device, by pressing esc while the “press the ESC key for Startup
Menu” message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot
Device Options menu.

●

To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device
each time the computer is turned on or restarted.

Setting a new boot order in Computer Setup
To start Computer Setup and set a boot device order that the computer uses each time it is turned on
or restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then
press enter.

4.

To move the device up in the boot order, use a pointing device to click the up arrow, or
press the + key.
– or –
To move the device down in the boot order, use a pointing device to click the down arrow, or
press the - key.

5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:
1.

Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc
while the “press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2.

press f9.

3.

Use a pointing device or the arrow keys to select a boot device, then press enter.
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Setting a MultiBoot Express prompt
To start Computer Setup and set the computer to display the MultiBoot startup location menu each time
the computer is started or restarted, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select System Configuration > Boot Options,
and then press enter.

4.

In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that
you want the computer to display the startup location menu before it defaults to the current
MultiBoot setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)

5.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Entering MultiBoot Express preferences
When the Express Boot menu is displayed during startup, you have the following choices:
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●

To specify a boot device from the Express Boot menu, select your preference within the allotted
time, and then press enter.

●

To prevent the computer from defaulting to the current MultiBoot setting, press any key before the
allotted time expires. The computer will not start until you select a boot device and press enter.

●

To allow the computer to start according to the current MultiBoot settings, wait for the allotted time
to expire.
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Using HP PC Hardware Diagnostics (UEFI) (select models only)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run
diagnostic tests to determine if the computer hardware is functioning properly. The tool runs outside of
the operating system to isolate hardware failures from issues that may be caused by the operating
system or other software components.
To start HP PC Hardware Diagnostics UEFI:
1.

Turn on or restart the computer, quickly press esc, and then press f2.
After pressing f2, the BIOS searches three places for the HP PC Hardware Diagnostics (UEFI) tools
in the following order:
a.

Connected USB drive
NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 125.

2.

b.

Hard drive

c.

BIOS

Click the type of diagnostic test you want to run, and then follow the on-screen instructions.
NOTE: If you need to stop a diagnostic test while it is running, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only.
1.

Go to http://www.hp.com.

2.

Click Support & Drivers, and then click the Drivers & Software tab.

3.

Enter the product name in the text box, and then click Search.

4.

Select your computer model, and then select your operating system.

5.

In the Diagnostic section, click HP UEFI Support Environment.
– or –
Click Download, and then select Run.
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Specifications

Computer specifications
Metric

U.S.

Width

38.2 cm

15.0 in

Depth

25.7 cm

10.1 in

Height (front to rear, DreamColor display assembly)

3.4 to 3.9 cm

1.3 to 1.5 in

Height (front to rear, LED display assembly)

3.1 to 3.6 cm

1.2 to 1.4 in

Weight (computer equipped with Intel Dual Core
processor, 320-GB hard drive, optical drive, one
memory module, WLAN module, fingerprint reader,
modem module, and 8-cell battery)

2.93 kg

6.46 lb

Weight (computer equipped with Intel Dual Core
processor one memory module, 128-GB solid-state
drive, WLAN module, fingerprint reader, and 8-cell
battery)

2.82 kg

6.22 lb

Dimensions

Input power
Operating voltage and current

19.5 V dc @ 6.15 A - 120 W, Slim Smart AC Adapter (select
models only)
19.5 V dc @ 7.69 A - 150 W, Slim Smart AC Adapter (select
models only)
19.5 V dc @ 10.3A - 200 W, Slim Smart AC Adapter (select
models only)

Temperature
Operating

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity (non-condensing)
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
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Metric

U.S.

Operating

-15 m to 3,048 m

-50 ft to 10,000 ft

Nonoperating

-15 m to 12,192 m

-50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.

Hard drive specifications
1-TB, 5400-rpm*

750-GB, 5400rpm**

640-GB, 5400rpm**

Height

9.5 mm

9.5 mm

9.5 mm

Length

100.4 mm

100.4 mm

100.4 mm

Width

69.9 mm

69.9 mm

69.9 mm

Weight

110 g

110 g

110 g

Interface type

SATA

SATA

SATA

Synchronous (maximum)

1.1 GB/sec

1.1 GB/sec

1.1 GB/sec

Security

ATA security

ATA security

ATA security

Single track

1.5 ms

1.5 ms

1.5 ms

Average (read/write)

11/13 ms

11/13 ms

11/13 ms

Maximum

22 ms

22 ms

22 ms

Logical blocks

1,953,525,168

1,465,149,168

1,250,263,728

Dimensions

Transfer rate

Seek times (typical read, including setting)

Disk rotational speed
Operating temperature

5400 rpm
0°C to 60°C (32°F to 140°F)

*1 TB = 1 trillion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.
**1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.
NOTE:

Certain restrictions and exclusions apply. Contact technical support for details.
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Hard drive specifications (continued)
500-GB, 5400rpm**

320-GB, 5400rpm**

Height

9.5 mm

9.5 mm

Length

100.4 mm

100.4 mm

Width

69.9 mm

69.9 mm

Weight

110 g

110 g

Interface type

SATA

SATA

Synchronous (maximum)

1.1 GB/sec

1.1 GB/sec

Security

ATA security

ATA security

1.5 ms

1.5 ms

1.5 ms

11/13 ms

11/13 ms

11/13 ms

22 ms

22 ms

22 ms

Single track

1.5 ms

1.5 ms

Average (read/write)

11/13 ms

11/13 ms

Maximum

22 ms

22 ms

Logical blocks

976,773,168

628,142,448

Dimensions

Transfer rate

Seek times (typical read, including setting)

Disk rotational speed
Operating temperature

5400 rpm
0°C to 60°C (32°F to 140°F)

*1 TB = 1 trillion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.
**1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.
NOTE:
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Backup and recovery

Windows 8
To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system restore
points. In case of system failure, you can use the backup files to restore the contents of your computer.
From the Start screen, type restore, click Settings, and then select from the list of displayed options.
NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in HP Support Assistant. To access HP Support Assistant from the Start screen, select the
HP Support Assistant app.
In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.
NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to HP Support Assistant. To access HP Support Assistant
from the Start screen, select the HP Support Assistant app.

Backing up your information
Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. The system repair media (select models only) are used to start up (boot) the computer
and repair the operating system in case of system instability or failure. Your initial and subsequent
backups allow you to restore your data and settings if a failure occurs.
On Start screen, type backup, click Settings, and then select Save backup copies of your files
with File History.
You can back up your information to an optional external hard drive or a network drive.
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Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:
NOTE: Be sure that the computer is connected to AC power before you start the backup process.
NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.
1.

From the Start screen, type backup, click Settings, and then select from the list of
displayed options.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see Using
Windows 8 operating system media (purchased separately) on page 132.
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Using the Windows recovery tools
To recover information you previously backed up:
▲

Access HP Support Assistant. To access HP Support Assistant from the Start screen, select the HP
Support Assistant app.

To recover your information using Automatic Repair, follow these steps:
CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. All
files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition and the Windows partition. From
the Start screen, type e, and then click File Explorer.
– or –
From the Start screen, type c, and then select Computer.
NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see Using Windows 8
operating system media (purchased separately) on page 132.

3.

If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4.

Select Troubleshoot, then select Advanced Options, and then select Automatic Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in HP Support Assistant. To access HP Support Assistant from the Start screen,
select the HP Support Assistant app.
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Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: From the Start screen, type C, and
then select Computer.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows 8 operating system media
(purchased separately) on page 132.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is display on the screen.

5.

Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)
To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on
the computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 8 operating system DVD:
NOTE: This process takes several minutes.
1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive
before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

After the repair is completed:

132

1.

Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Using Windows Refresh for quick and easy recovery
When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.
IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.
NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See HP Support Assistant for instructions on
reinstalling traditional applications. To access HP Support Assistant from the Start screen, select the HP
Support Assistant app.
NOTE: You may be prompted for your permission or password when using Refresh. See HP Support
Assistant for more information. To access HP Support Assistant from the Start screen, select the HP
Support Assistant app.
To start Refresh:
1.

From the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2.

Click Settings.

3.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4.

Scroll the right-side choices down to display Refresh your PC without affecting your files.

5.

Under Refresh your PC without affecting your files, select Get started, and follow the
onscreen instructions.

Remove everything and reinstall Windows
Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, apps, and settings from your computer, and reinstalls Windows.
IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.
You can initiate this option by using the f11 key or from the Start screen.
To use the f11 key:
1.

Press f11 while the computer boots.
– or –
Press and hold f11 as you press the power button.

2.

Choose your language.

3.

Choose your keyboard layout.
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4.

Select Troubleshoot from the boot options menu.

5.

Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:
1.

From the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2.

Click Settings.

3.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4.

Scroll the right-side choices down to display Remove everything and reinstall Windows.

5.

Under Remove everything and reinstall Windows, select Get started, and follow the
onscreen instructions.

Using HP Software Setup
HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted
from the system.
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1.

From the Start screen, type HP Software Setup, and select Apps.

2.

Open HP Software Setup.

3.

Follow the on-screen directions to reinstall drivers or select software.
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Windows 7
Your computer includes HP and Windows tools to help you safeguard your information and retrieve it if
you ever need to. These tools will help you return your computer to a proper working state, all with
simple steps. This section provides information about the following processes:
●

Creating recovery media and backups

●

Restoring and recovering your system

Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.
1.

After you successfully set up the computer, create HP Recovery media. This step creates a
Windows 7 operating system DVD and a Driver Recovery DVD. The Windows DVD can be used
to reinstall the original operating system in cases where the hard drive is corrupted or has been
replaced. The Driver Recovery DVD installs specific drivers and applications. See Creating
recovery media with HP Recovery Disc Creator on page 136.

2.

Use Windows Backup and Recovery tools to perform the following:
●

Back up individual files and folders

●

Back up your entire hard drive (select models only)

●

Create system repair discs (select models only) with the installed optical drive (select models
only) or an optional external optical drive

●

Create system restore points

NOTE: This guide describes an overview of backing up, restoring, and recovering options. For more
details about the tools provided, see Help and Support. To access Help and Support, select Start >
Help and Support.
NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.
In case of system failure, you can use the backup files to restore the contents of your computer. See
Backing up your information on page 136.

Guidelines
●

When creating recovery media or backing up to discs, use any of the following types of discs
(purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use
will depend on the type of optical drive you are using.

●

Be sure that the computer is connected to AC power before you start the recovery media creation
process or the backup process.
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Creating recovery media with HP Recovery Disc Creator
HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media allows you to reinstall your original operating system as well as
select drivers and applications if the hard drive becomes corrupted. HP Recovery Disc Creator can
create two kinds of recovery DVDs:
●

Windows 7 operating system DVD—Installs the operating system without additional drivers
or applications.

●

Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

Creating recovery media
NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to
create that media will not be available after you create a Windows DVD.
To create the Windows DVD:
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Windows disk.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Create button to start the burning process.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Driver disk.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Create button to start the burning process.

Backing up your information
You should create system repair media and your initial backup immediately after initial system setup.
As you add new software and data files, you should continue to back up your system on a regular
basis to maintain a reasonably current backup. You should also create Windows system repair media
(select models only) which can be used to start up (boot) the computer and repair the operating system
in case of system instability or failure. Your initial and subsequent backups allow you to restore your
data and settings if a failure occurs.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
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●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated directories.
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●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

●

When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. To access Help and Support, select Start > Help and Support.
NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support. To access Help and Support, select
Start > Help and Support.
To create a backup using Windows Backup and Restore:
NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools (select models only): You can use the f11 recovery tools to recover your original
hard drive image. The image includes the Windows operating system and software programs
installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 7 operating system
media to reboot the computer and repair the operating system. For additional information, see Using
Windows 7 operating system media on page 139.
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Using the Windows recovery tools
Using the Windows recovery tools, you can:
●

Recover individual files

●

Restore the computer to a previous system restore point

●

Recover information using recovery tools

NOTE: For detailed instructions on various recovery and restore options, perform a search for these
topics in Help and Support. To access Help and Support, select Start > Help and Support.
NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support. To access Help and Support, select
Start > Help and Support.
To recover information you previously backed up:
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:
CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition.
To check for the Windows partition, select Start > Computer.
NOTE: If the Windows partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery media. For
additional information, see Using Windows 7 operating system media on page 139.

3.

If the Windows partition is listed, restart the computer, and then press f8 before the Windows
operating system loads.

4.

Select Startup Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, select Start >
Help and Support.
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Using f11 recovery tools (select models only)
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system media and the Driver Recovery media. For
additional information, see Using Windows 7 operating system media on page 139.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.

Using Windows 7 operating system media
If you cannot use the recovery media you previously created using the HP Recovery Disc Creator (select
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and
repair the operating system.
To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http://www.hp.com/support. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on
the computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD:
NOTE: This process takes several minutes.
1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

Windows 7
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5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.

After the repair is completed:
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1.

Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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10 Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in
industry-standards based HP Business Notebook PC systems and provide general instructions for
restoring nonvolatile memory that can contain personal data after the system has been powered off and
the hard drive has been removed.
HP Business Notebook PC products that use Intel®-based or AMD®-based system boards contain
volatile DDR memory. The amount of nonvolatile memory present in the system depends upon the
system configuration. Intel-based and AMD-based system boards contain nonvolatile memory
subcomponents as originally shipped from HP assuming that no subsequent modifications have been
made to the system and assuming that no applications, features, or functionality have been added to or
installed on the system.
Following system shutdown and removal of all power sources from an HP Business Notebook PC
system, personal data can remain on volatile system memory (DIMMs) for a finite period of time and
will also remain in nonvolatile memory. The steps below will remove personal data from the notebook
PC, including the nonvolatile memory found in Intel-based and AMD-based system boards. Some of
these steps are disclosed in the Maintenance & Service Guides available for HP PC products available
on the product support pages at www.hp.com.
1.

Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal
data. Restoring or re-programming nonvolatile memory that does not store personal data is neither
necessary nor recommended.
a.

Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near
the bottom of the display, or press the ESC key to display the start up menu, then press F10 .
If the system has a BIOS administrator password, enter the password at the prompt.

b.

Select the File menu, then Restore Defaults.

c.

Select the System Configuration menu, then Restore Security Defaults.

d.

If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities
menu. Select System IDs, and then select the tag that has been set. Press the spacebar
once to clear the tag, then press Enter to return to the prior menu.

e.

If a DriveLock password is set, select the Security menu, select Hard Drive Tools, scroll
down to DriveLock, then select DriveLock password. Select the desired hard drive.
Click Disable protection, enter the existing master DriveLock password, then press Enter to
confirm and return to the prior menu. Repeat this procedure if more than one hard drive has
a DriveLock password.
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f.

If an Automatic DriveLock password is set, select the Security menu, select Hard Drive
Tools, scroll down to Automatic DriveLock, then select the desired hard drive and
disable protection. Repeat this procedure if more than one hard drive has an Automatic
DriveLock password.

g.

Select the File menu, then Reset BIOS Security to factory default. Click yes at the
warning message.

h.

Select the File menu, then Save Changes and Exit.

i.

Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint
sensor, one or two prompts will appear. One to clear the TPM and the other to Reset
Fingerprint Sensor; press F1 to accept or F2 to reject.
If the HP notebook model number includes Intel® Centrino with VPro™, reboot the PC and
enter BIOS Setup by pressing F10 when prompted. Select System Configuration, then
AMT Options. Then select Un-configure AMT on next boot. Select Save then Yes.
Select the File menu, and then select Save Changes and Exit. Reboot the system and
confirm that you want to un-configure AMT.

2.

j.

If the optional Intel® Anti-Theft Technology (AT) was activated, contact the provider to deactivate it.

k.

If the optional Absolute® Software Computrace® management and tracking service was
activated on the notebook PC, contact the provider to deactivate it.

l.

Remove all power and system batteries for at least 24 hours.

Remove and retain the storage drive or clear the contents of the drive.
a.

Hard Disk Drive (HDD)
Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application
that, ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.
To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10
when prompted near the bottom of the display, or press ESC to display the start up menu,
then press F10. Select the Security menu and scroll down to the Utilities menu. Select
Disk Sanitizer and select the desired drive. For a higher level of protection, select
Optimum.
NOTE: This process will take a long time, and the amount of time varies based on the hard
drive capacity.

b.

Solid State Drive (SSD)
Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a
third party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup
by powering on the system and pressing F10 when prompted near the bottom of the display.
Select the Security menu and scroll down to the Utilities menu. Select Secure Erase and
select the desired hard drive.
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Non-volatile memory usage
Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain
data
when
power is
removed?

What is the
purpose of
this
memory?

How is data input into
this memory?

How is this memory
write protected?

HP Sure Start
flash

2 MB

No

Yes

Only in
platforms that
support Sure
Start to
provide
protected
backup of
critical System
BIOS code, EC
firmware, and
critical PC
configuration
data.

Data cannot be written to this
device via the host
processor. The content is
managed solely by the HP
Sure Start Embedded
Controller.

Protected by the HP Sure
Start Embedded
Controller.

Real Time Clock
(RTC) battery
backed-up
CMOS
configuration
memory
(CMOS)

256 Bytes

No

Yes

Stores system
date and time
and limited
keyboard
controller data.

Using the F10 Setup utility or
changing the Microsoft®
Windows® date & time.

This memory is not writeprotected. HP
recommends password
protecting the F10 Setup
utility.

Controller (NIC)
EEPROM

64 Kbytes
(not customer
accessible)

No

Yes

Store NIC
configuration
and NIC
firmware.

Using a utility from the NIC
vendor that can be run from
DOS.

A utility is required to
write data to this memory
and is available from NIC
vendor. Writing data to
this ROM in an
inappropriate manner will
render the NIC nonfunctional.

Keyboard ROM

64 Kbytes
(not customer
accessible)

No

Yes

Stores
firmware code
(keyboard,
mouse, &
battery
management).

Programmed at the factory.
Code is updated when the
system BIOS is updated.

A utility is required for
writing data to this
memory and is available
on the HP website.
Writing data to this ROM
in an inappropriate
manner can render the PC
non-functional.

DIMM Serial
Presence Detect
(SPD)
configuration
data

256 Bytes
per memory
module, 128
Bytes
programmab
le (not
customer
accessible)

No

Yes

Stores memory
module
information.

Programmed by the memory
vendor.

Data cannot be written to
this memory when the
module is installed in a
PC. The specific write
protection method varies
by memory vendor.

Non-volatile memory usage
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Non Volatile
Memory
Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain
data
when
power is
removed?

What is the
purpose of
this
memory?

How is data input into
this memory?

How is this memory
write protected?

System BIOS

4 to 5
MBytes

Yes

Yes

Store system
BIOS code
and PC
configuration
data.

System BIOS code is
programmed at the factory.
Code is updated when the
system BIOS is updated.
Configuration data and
settings are input using the
F10 setup utility or a custom
utility.

A utility is required for
writing data to this
memory and is available
on the HP website.
Writing data to this ROM
in an inappropriate
manner can render the PC
non-functional.

Intel
Management
Engine
Firmware
(present only in
models ending
in a ‘p’ or ‘w’
or with Intel
Centrino Pro
technology)

1.5 or
5MByte

Yes

Yes

Stores
Management
Engine Code,
Settings,
Provisioning
Data and
iAMT third
party data
store.

Management Engine Code is
programmed at the factory.
Code is updated via Intel
secure firmware update
utility. Unique Provisioning
Data can be entered at the
factory or by an
administrator using the
Management Engine (MEBx)
setup utility. The third party
data store contents can
populated by a remote
management console or local
applications registered by an
administrator to have access
to the space.

The Intel chipset is
configured to enforce HW
protection to block all
direct read/write access
to this area. An Intel utility
is required for updating
the firmware. Only
firmware updates digitally
signed by Intel can be
applied using this utility.

Bluetooth flash

2Mbit

No

Yes

Stores
Bluetooth
configuration
and firmware.

Programmed at the factory.
Tools for writing data to this
memory are not publicly
available but can be
obtained from the silicon
vendor.

A utility is required for
writing data to this
memory and is made
available through newer
versions of the driver if the
flash requires an upgrade.

802.11 WLAN
EEPROM

4kb to 8kb

No

Yes

Stores
configuration
and
calibration
data.

Programmed at the factory.
Tools for writing data to this
memory are not made public.

A utility is required for
writing data to this
memory and is typically
not made available to the
public unless a firmware
upgrade is necessary to
address a unique issue.

Web Camera

64K bit

No

Yes

Store Web
Cam
configuration
and firmware.

Using a utility from the device
manufacturer that can be run
from Windows.

A utility is required for
writing data to this
memory and is typically
not made available to the
public unless a firmware
upgrade is necessary to
address a unique issue.

Fingerprint
Reader

512kByte
Flash

Yes

Yes

Stores
fingerprint
templates.

By enrolling in HP
ProtectTools Security
Manager.

Only a digitally signed
application can make the
call to write to the flash.
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Questions and answers
1.

2.

How can the BIOS settings be restored (returned to factory settings)?
a.

Turn on or restart the computer and press F10 when prompted near the bottom of the display.

b.

Select File, then select Restore defaults.

c.

Follow the on-screen instructions.

d.

Select File, save changes and exit, then press Enter.

What kind of configuration data is stored on the DIMM Serial Presence Detect
(SPD) memory module? How would this data be written?
The DIMM SPD memory contains information about the memory module such as size, serial
number, data width, speed/timing, voltage and thermal information. This information is written by
the module manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the
memory module is installed in a PC. Third party tools do exist that can write to the EEPROM when
the memory module is not installed in a PC. There are various third party tools available to read
SPD memory.

3.

Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip
writable, and if so how?
The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform
the write function.

4.

In some PC systems, the Firmware Hub for System BIOS is a flash memory chip
so that updates can be written by the customer. Is this true for these BIOS chips?
Yes, they are flash memory chips.

5.

What is meant by “Restore the nonvolatile memory found in Intel-based system
boards”?
This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration
data.

6.

Does resetting the CMOS configuration memory return the PC back to factory
defaults?
The process of resetting the CMOS will return certain system settings to factory default but will not
reset many of the system data and configuration defaults to their factory settings. To return these
system data and configuration defaults to factory settings, refer to question and answer 1 and
follow the instructions for returning the BIOS settings to factory defaults.

Questions and answers
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11 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
Requirements for all countries 113

Requirements for specific countries and regions
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Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1
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Country/region

Accredited agency

Applicable note number

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

COC

5

South Korea

EK

4

Sweden

CEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

Requirements for specific countries and regions
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12 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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Index

A
AC adapter, spare part number
38
AC adapter, spare part numbers
35
AC adapter/battery light 15, 18
accessory battery connector 19
antenna, locations 8
audio, product description 4
audio-in jack 17
audio-out jack 17
audio/USB board
removal 85
spare part number 26, 40, 85
B
base enclosure, spare part
number 27, 40
battery
removal 50
spare part numbers 28, 37,
38, 50
battery bay 19
battery release latch 19
Blu-ray R/RE DVD±RW SuperMulti
Double-Layer Drive
precautions 45
removal 54
spare part number 28, 35,
42, 54
Blu-ray ROM DVD±RW SuperMulti
Double-Layer Drive
precautions 45
removal 41, 54
spare part number 28, 35,
41, 54
bottom components 19

Bracket Kit
components 31
spare part number 31, 41
button components 10
buttons
optical drive eject 17
pointing stick 14
power 10
TouchPad 14
TouchPad on/off 14
volume mute 11
Windows key 12
wireless 11
C
Cable Kit
components 32
spare part number 32, 40
cable lock, spare part numbers
35, 37, 38
cables, service considerations 45
caps lock light 13
carrying case, spare part number
35, 38
chipset, product description 1
components
bottom 19
buttons 10
display 8
fingerprint reader 10
front 15
keys 12
left-side 16
lights 13
rear 18
right-side 17
speakers 10
TouchPad 14

computer
major components 23
specifications 126
connectors, service
considerations 45
D
dispay switch 9
display assembly
removal 96
spare part numbers 24, 42,
96
display bezel
removal 100
spare part numbers 30, 41,
100
display components 8
display panel
product description 2
removal 101
spare part numbers 30, 42
Display Panel Support Kit, spare
part number 41
docking connector 19
drives, preventing damage 45
Dual-Mode DisplayPort 16
DVD-ROM Drive
precautions 45
removal 54
spare part number 28, 35,
42, 54
DVD±RW SuperMulti Double-Layer
Drive
precautions 45
removal 54
spare part number 28, 35,
42, 54

Index
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E
electrostatic discharge 46
equipment guidelines 48
esc key 12
Ethernet, product description 4
ExpressCard assembly
removal 81
spare part number 26, 40, 81
ExpressCard reader bezel,
illustrated 33
ExpressCard slot 16
external monitor port, location 17
F
fan/heat sink assembly
removal 90
spare part numbers 26, 40,
41, 90
fingerprint reader
component 10
location 11
fingerprint reader bezel,
illustrated 33
fingerprint reader blank cover,
illustrated 33
fingerprint reader board
removal 75
spare part number 26, 40, 75
fingerprint reader board bracket
illustrated 31
removal 75
flash cache, product description 2
fn key 12
front components 15
function button board
removal 77
spare part number 26, 40, 77
function keys 12
G
graphics board
removal 94
spare part numbers 27, 40,
42, 94
graphics, product description 1
grounding guidelines 46
guidelines
equipment 48
grounding 46
packaging 47
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Index

transporting 47
workstation 47
H
hard drive
precautions 45
product description 3
removal 52
spare part numbers 28, 34,
37, 38, 52
specifications 127
hard drive bracket
illustrated 34
removal 53
Hard Drive Hardware Kit
contents 34
spare part number 28, 34, 40
hard drive light 15
hard drive upgrade bay, spare part
number 28, 35, 41, 54
headphone jack 17
hinge
removal 102
spare part number 30, 42,
103
hinge cover
removal 97
spare part number 41, 97
Hinge Cover Kit, spare part
number 24
Hinge Kit, spare part number 42
I
integrated numeric keypad 12
J
jacks
audio-in 17
audio-out 17
headphone 17
microphone 17
K
key components 12
keyboard
product description 5
removal 62
spare part numbers 24, 38,
39, 40, 42, 43, 62
keys
esc 12

fn 12
function 12
integrated numeric keypad 12
num lk 12
L
left-side components 16
light components 13
lights
AC adapter/battery 15, 18
caps lock 13
hard drive 15
microphone mute 13
mute 13
num lock 13
power 13, 15
webcamera 8
wireless 13, 15, 18
M
mass storage device
illustrated 34
precautions 45
spare part numbers 34
memory card reader 17
memory module
product description 2
removal 61, 67
spare part numbers 26, 27,
37, 38, 61, 67
microphone
location 8
product description 4
microphone jack 17
microphone module
removal 102
spare part number 30, 41,
102
microphone mute light 13
model name 1
monitor port 17
mouse, spare part numbers 35,
37
mute light 13
N
network cable
illustrated 32
removal 109
num lk key 12
num lock light 13

O
operating system, product
description 6
optical drive
location 17
precautions 45
removal 54
spare part numbers 28, 35,
42, 54
optical drive eject button 17
P
packaging guidelines 47
plastic parts, service
considerations 44
Plastics Kit
components 33
spare part number 33, 41
pointing device, product
description 5
pointing stick 14
pointing stick button 14
ports
Dual-Mode DisplayPort 16
external monitor 17
monitor 17
product description 5
Thunderbolt 16
USB 2.0 16
USB 3.0 17, 18
USB 3.0 charging 16
power button 10
power button board
removal 79
spare part number 26, 40, 79
power connector 18
power connector cable
illustrated 32
removal 107
power cord
set requirements 146
spare part numbers 35, 37
power light 13, 15
power requirements, product
description 5
processor
product description 1
removal 93
spare part numbers 26, 38,
42, 93

product description
audio 4
chipset 1
display panel 2
Ethernet 4
external media cards 4
flash cache 2
graphics 1
hard drive 3
keyboard 5
memory module 2
microphone 4
operating system 6
pointing device 5
ports 5
power requirements 5
processor 1
product name 1
security 6
serviceability 7
solid-state drive 2
Upgrade drive 3
video 4
wireless 4
product name 1
R
rear components 18
rear corner cover
removal 105, 109
spare part number 105, 110
removal/replacement
procedures 49, 69
right-side components 17
RJ-45 cable
illustrated 32
removal 109
RTC battery
removal 69
spare part number 28, 41, 69
S
Screw Kit, spare part number 36,
40
SD card reader bezel, illustrated
33
security cable lock bracket
illustrated 31
removal 110
spare part number 110

security cable slot, location 16
security, product description 6
service considerations
cables 45
connectors 45
plastic parts 44
service cover
location 20
removal 51
spare part number 28, 40, 51
service cover release latch 19
service cover release lock 19
service tag 21
serviceability, product description
7
SIM slot 19
smart card reader 16
removal 83
spare part number 26, 42, 83
solid-state drive
precautions 45
product description 2
removal 58
spare part numbers 27, 34,
41, 42, 58
speaker components 10
Speaker Kit, spare part number
27
speakers
location 11
removal 89
spare part number 27, 41, 89
specifications
computer 126
hard drive 127
system board
removal 103
spare part numbers 27, 41,
103
system lens
illustrated 33
removal 81
T
Thunderbolt port 16
tools required 44
top cover
removal 71
spare part number 26, 40, 71
TouchPad button 14
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TouchPad components 14
TouchPad on/off button 14
TouchPad zone 14
transporting guidelines 47
U
Upgrade drive, product
description 3
USB 2.0 port 16
USB 3.0 charging port 16
USB 3.0 port 17, 18
USB board
removal 87
spare part number 27, 41, 87
V
vents 16, 20
video, product description 4
volume mute button 11
W
webcamera 9
webcamera light 8
webcamera/microphone module
removal 102
spare part number 30, 41,
102
Windows button 12
wireless antenna, locations 8
wireless button 11
wireless light 13, 15, 18
wireless, product description 4
WLAN module
removal 59
spare part numbers 28, 37,
38, 59
workstation guidelines 47
WWAN module
removal 56
spare part numbers 28, 38,
56

152

Index

